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5 Levelling Up Locally 

Levelling up is an ambitious mission. Britain’s regional divides have developed over 
decades, leaving communities fractured and economies hollowed out. Governments 
of every party and persuasion have made tackling the problem a priority. And yet it 
persists. The Levelling Up White Paper outlined a new strategy across over 300 
pages, combining twelve long-term missions with steps to change how Whitehall 
works and the creation of new departmental programmes. The Westminster debate 
has focussed on the national challenge. 

But levelling up is inherently local. The problems are most keenly felt in boarded up 
shops and run down town centres. It is about safe streets and clean parks just as 
much as increasing productivity and employment. Restoring pride in place and 
addressing the hyper-local roots of deprivation must be the initial, practical steps 
towards long-term change. But the practical interventions to kickstart levelling up 
locally are not well understood and rarely shared. Only by properly diagnosing the 
problem and developing solutions at a local level can we achieve the national goal. 

Onward’s Levelling Up In Practice programme seeks to address this gap. In 2022 we 
spent time in areas across the country talking to local leaders and members of the 
public to understand what mattered to them. Our premise is that while national 
policy is important, most of the intelligence, levers, and energy to level up are found 
locally. By identifying and sharing what works in the form of a practical playbook for 
local leaders, we hope to catalyse progress. This report is the final product of our 
research programme, and builds on interim case studies of the five areas we spent 
time in: Oldham, South Tyneside, Walsall, Clacton, and Barry. 

Our conversations across the country identified five common challenges. These 
issues are consistently raised by the public, observable in the data, and stubbornly 
persist over time: 

1. Tackling antisocial behaviour, particularly among young people 

2. Bringing life back to high streets and town centres 

3. Supporting local sport, culture, heritage and green space 

4. Boosting local growth in the private sector 

5. Providing community-based support to the most disadvantaged 

In every area, these common challenges had particular characteristics and blocked 
levelling up to differing degrees. In Oldham, antisocial behaviour on public transport 
restricted connectivity and hollowed out the town centre. In South Tyneside, 
extreme health inequalities drove economic inactivity and held back industry, while 
community-assets remained untapped. 
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And in some of the areas we visited, these five common challenges even varied 
between neighbourhoods. In Clacton, poverty was concentrated in clusters of streets 
with poor housing stock and among elderly residents with little family support, both 
placing high pressure on public services. In Walsall, the drivers of economic 
inactivity varied from ward to ward between low levels of formal skills, chronic 
health conditions, ageing workers, and cultural norms in ethnic minority 
communities. 

These two factors - variation in the most pressing barriers to progress between areas 
and the presence of hyper-local challenges within areas - point to the need to tackle 
these challenges locally. We need to level up from the bottom up.  

Local leaders face an uphill battle. They are underpowered, with decisions taken too 
often in Whitehall instead of by communities, councillors or mayors. Local 
government faces a difficult financial situation, with funding reduced significantly 
since 2010 and pressures on public services rising. And national policy needs to 
better support local efforts: other Onward research has set out recommendations 
aimed at Westminster on topics including growth-enhancing spending, transport, 
apprenticeships, investment, innovation and schools. 

But local progress is already happening. Our research took us to Barry in South 
Wales, a working-class town already well on its way to being levelled up. The area 
has seen a major physical regeneration over the last 30 years, with new housing 
projects on former industrial land developed in partnership between the council and 
the community. Local entrepreneurs have created new economic and civic assets 
that have underpinned renewal. Proactive neighbourhood policing has tackled 
antisocial behaviour and brought back family tourism. Economic plans have 
harnessed the relationship between Barry and nearby Cardiff, boosting connectivity 
and creating integrated skills programmes. And the town had luck, gaining fame as 
the setting for TV show Gavin and Stacey. 

We have collected the most promising interventions we saw across the country into 
a practical playbook. We have looked at examples that have worked from local 
governments led by a variety of political parties. The steps we have set out are low-
cost, fast acting, and within the powers currently held by local leaders. They may not 
solve long-term intractable problems alone, but they can be the first steps. We look 
forward to working with local leaders across the country to pilot and measure some 
of these interventions. 
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Challenges Interventions 

 
1. Tackling antisocial 
behaviour, particularly 
among young people 

 
1.1 Local leaders can collectively identify antisocial behaviour hot spots and 
focus their resources on solving underlying problems in those areas 

1.2 Local leaders can improve safety on buses, trams and trains, as well as 
public transport stops and stations 

1.3 Local leaders can support programmes that divert young people away 
from antisocial behaviour, including sport, after school clubs, and mentoring 

 
2. Bringing life back to 
high streets and town 
centres 

 
2.1 Councils can issue letters notifying landlords of long-term vacant 
properties of their intention to trigger a High Street Rental Auction 
 
2.2 Councils can tackle eyesores and derelict buildings through Section 215 
notices 
 
2.3 Local leaders can increase collective capacity to improve the public 
realm through the formation of parish and town councils, Business 
Improvement Districts and Community Improvement Districts 
 
2.4 Councils can enable the transfer of assets to community ownership 
 
2.5 Local leaders can create thriving town markets 

 
 
3. Supporting local 
sport, culture, heritage 
and green space 

 
3.1 Local leaders can create Heritage Development Trusts and councils can 
designate Heritage Action Zones to protect and improve access to heritage 
assets 
 
3.2 Local leaders can ensure the sustainability of local sports clubs 
 
3.3 Local leaders can create diaspora networks as a way to boost pride of 
place and increase philanthropic investment  
 
3.4 Councils can support programmes to animate the public realm through 
culture and art 
 
3.5 Local leaders can create “pocket parks” in urban areas 

 

Summary: Playbook of Interventions 

 

Summary of recommendations 
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4. Boosting local 
growth in the private 
sector 

 
4.1 Local leaders can develop hyper-local industrial strategies 
 
4.2 Local leaders can provide targeted business support and advice to 
tradeable firms with high growth potential 
 
4.3 Local leaders can create new partnerships between businesses, 
schools, colleges, and universities to boost employment 
 
4.4 Local leaders can increase the supply of employment land by creating 
Mayoral and Locally Led Development Corporations 
 
4.5 Local leaders can introduce Demand Responsive Transit schemes to 
boost physical connectivity 

 
 
5. Providing 
community-based 
support to the most 
disadvantaged 

 
5.1 Local leaders can create and support networks that build relationships 
between vulnerable groups like the long-term unemployed 
 
5.2 Local leaders can launch community public health campaigns to 
increase well-being 
 
5.3 Local authorities can create and expand Family Hubs in their areas 
 
5.4 Local leaders can introduce new forms of community engagement to 
develop and improve services 
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The levelling up agenda is about unlocking opportunity in parts of the country that 
have been left behind for decades. This is not an easy task, and this Government is 
not the first to attempt it. To date, many of the policies and interventions announced 
to support levelling up have emanated from Whitehall departments in the form of 
new funding pots or national policy programmes. 

Onward’s Levelling Up in Practice programme started from the premise that even if 
national policy is important, most of the intelligence and energy to level up will be 
found locally. And while too many policy levers sit in Westminster, there are still 
important tools available to local councillors, business leaders, and civic groups. 

But places’ ability to level themselves up is hampered by the fact there is currently no 
agreed methodology for practical change, and certainly not one rooted in evidence 
and informed by the views of local communities. In most other policy areas we learn 
and replicate from what works on the ground, but not when it comes to 
regeneration. 

In some communities positive change is already happening, with inspiring local 
leaders taking steps to turn around the fortunes of their places. These examples are 
the exception not the rule, and the replicable lessons from these “bright spots” are 
not well understood.  

This is the problem addressed by Onward’s Levelling Up in Practice programme. 
Working closely with communities, local leaders and businesses, we identified 
common challenges that attempts to level up needed to tackle. Through this process 
we developed an approach to using data to diagnose which of these challenges is 
most pressing in an area, to support local leaders in prioritising their work. And 
finally we brough together a set of evidence-based and replicable interventions that 
can be tailored to local contexts to make progress on these challenges. 

Our work was rooted in five research visits across the country to areas in need of 
levelling up: Oldham in the North West, South Tyneside in the North East, Walsall in 
the West Midlands, Clacton in the East of England, and Barry in South Wales. In each 
place we spoke with local politicians, business leaders, community groups, and 
public service leaders, as well as holding focus groups to hear directly from 
communities themselves. Alongside these structured visits, our work was informed 
by time spent in other parts of the country throughout 2022 including Barnstaple, 
Birkenhead, Stourbridge, and Halifax. 

The rest of this report looks at three areas in turn: identifying the common 
challenges we found; using data to prioritise between them; and taking concrete 
action locally. 
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Every area we focused on for this programme had one thing in common: a high level 
of economic and social need that holds back opportunity. There will be other parts of 
the country that will have more acute economic and social challenges, but these five 
areas provide a good representation of the kinds of places where potential is 
untapped. 

Economically, all are below average in terms of both productivity and material 
welfare. Oldham, Walsall and South Tyneside were manufacturing epicentres in the 
18th century for textiles, leather tack and ships respectively, but are now among the 
poorest 10% of local authorities in the UK in terms of Gross Disposable Household 
Income. Tendring and the Vale of Glamorgan fare better in comparison, but our 
areas of study within these authorities - Clacton-on-Sea and Barry - have 
comparable disposable incomes to Oldham, Walsall and South Tyneside. In terms of 
productivity, all areas rank among the least productive 20% of local authorities in the 
UK, as measured by Gross Value Added per capita. 

Figure 1: Gross Value Added (GVA) per capita vs Gross Disposable Household Income 
(GDHI) per capita, in percentile ranks  
Source: ONS Regional Accounts, 2019, Onward analysis 

These places also have a weak social fabric. Every area apart from the Vale of 
Glamorgan has a low score on Onward’s social fabric index, which includes data on 
volunteering, membership of local groups, the physical infrastructure of places like 
shops and green spaces, trust in civic institutions, crime rates and family formation. 
Again, strong scores for the Vale of Glamorgan overall obscure challenges in Barry, 
where our work was focussed. Comparing each area to their corresponding regional 
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averages also gives important context. While South Tyneside and Tendring have 
social fabric scores that are fairly representative of the North East and East of 
England respectively, Walsall and Oldham have some of the lowest social fabric 
scores in their regions. When it comes to reported levels of belonging, areas in the 
North of England characteristically have higher scores than parts of the South and 
Midlands. 
 
Figure 2: Belonging Scores vs Social Fabric, in percentile ranks 
Source: Onward Social Fabric data 2020, Understanding Society ‘Belonging’ scores, 
Onward analysis 

 
As we spent time in these areas, speaking to local leaders and residents, five common 
challenges and priorities began to emerge. They differed in severity, and all had local 
features and characteristics, but these five problems nonetheless crystallised the 
longer we inquired about what was needed to level up. 

These five local priorities are rooted in the practical and everyday challenges that 
the public and local leaders want to see addressed. Alone, they will not be sufficient 
to reverse decades of diverging economic and social outcomes across the country. 
Onward has written extensively on some of the large-scale systemic changes that 
are needed- including on apprenticeships, devolution, innovation, foreign direct 
investment, local government finance, tax, and schools. All of these measures are 
necessary, but they will take time. The five priorities outlined here are areas where 
both local and national governments can make tangible progress more rapidly. To 
succeed, the Government needs to level up fast and slow. These five areas should be 
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1. Tackling crime and antisocial behaviour, particularly 
among young people 
 
Frustrations with high levels of crime are about losing control. In Oldham, large 
numbers of young people congregating around tram stops and harassing passengers 
stopped people using public transport: one told us “you take your life in your hands 
for a £3.60 return”. In Clacton, groups of men drinking around the fountain in the 
town square drove away both residents and potential visitors. In Walsall, some 
neighbourhoods had gained such a reputation for violence and intimidation that 
residents didn’t feel they were able to drive through them. In all of these examples, 
the local residents felt powerless.  
 
The data supports these claims. Public order offences today are 4.4 times higher in 
the area around Clacton than they were in 2015, compared to a roughly 2.5 times 
increase across England and Wales. Figure 3 shows how all the areas we visited 
reported growth in public order offences higher than the national average from 2006 
to 2022. And this only captures a portion of antisocial behaviour in local areas, much 
of which is not reported to the police but to local authorities or other public bodies 
who come together in Community Safety Partnerships. And much antisocial 
behaviour is never officially reported at all, particularly where the public don't have 
confidence anything will be done. Many of the areas that we spent time in report 
lower levels of trust in the police compared to the UK average, as shown in Figure 4. 
 
Figure 3: Number of recorded public order offences, 2006-22 (Index 2006 = 100) 
Source: Home Office police recorded crime by Community Safety Partnership, Onward 
analysis  

*Note: The above data is by Community Safety Partnership (CSP) which equate in the 
majority of instances to local authorities. The England and Wales total in this figure is that of 
CSPs, which is different to total crime in England and Wales as it does not account for British 
Transport Police data and areas not covered by CSPs. 
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Figure 4: Trust in Police scores 
Source: Onward Social Fabric data 2020 

*Note: The Survey question asked “I will name a list of institutions. For each, please indicate 
whether you tend to trust it or tend not to trust it.” 
 
In almost every area we spent time in, this put tackling crime and reducing antisocial 
behaviour as the public’s top priority for levelling up. This often came as a shock to 
local leaders, particularly elected councillors. They may have been aware of crime as 
one challenge among many, but didn’t see it as the key factor holding them back. But 
for members of the public, feeling safe on the streets was an essential foundation to 
other routes to regeneration: commuting to better paying jobs, spending money in 
shops or restaurants in the town centre, or becoming a member of a new community 
group.  
 
Frustrations around antisocial behaviour focused on young people. Some of this 
criticism is to be expected: research has shown that older generations have always 
felt younger generations are disrespectful or unruly.1 But concern was often the key 
message, not criticism. In Oldham, members of the public didn’t blame young people 
for loitering, but pointed to the lack of youth services or sports clubs to engage with. 
In each area we conducted an exercise where we asked focus group participants to 
form a “levelling up taskforce” and recommend three concrete actions they would 
introduce to improve their town. “More activities for young people” was a top 
recommendation in every single area we visited. 
 
A perceived lack of community policing made people feel unsafe. People we spoke to 
recognised that there were real pressures on police funding and numbers, and were 
quick to support individual officers they knew in their areas. But they felt that overall 
the police didn’t have time to patrol the streets or tackle “low-level crimes” that 
affected them. In both Walsall and South Tyneside, the recent closures of local police 
stations were seen as a symbolic retreat by police forces from their towns. 
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2. Bringing life back to high streets and town centres 
 
Town centres are symbolic of an area’s fortunes. Residents often rush to tell you 
about their pride in past glories. In Oldham it was Tommyfield Market: the first place 
in the country to sell fish and chips. In South Tyneside it was King Street, which one 
business leader told us had commanded the highest retail rents in the country in the 
1980s.  
 
Today, the same phrases are used to describe town centres in the places most in 
need of levelling up: “run down”, “grim”, “lost”, “tired”, “bleak”. Data indicates that the 
areas we visited, plus places the Government has prioritised for levelling up, have 
particularly high vacancy rates. Even where town centre premises were not vacant, 
they were more likely to be charity stores or betting shops than independent cafes 
or big brands. 
 
Figure 5: Vacancy rates for leisure and rental units, 2021 
Source: Whythawk commercial location data, Onward analysis 
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Figure 6:  Number of independent businesses per 1,000 population, 2020 
Source: ONS data on number of businesses operating a single site, Onward analysis 

Residents acknowledged that the struggling town centre hadn’t been the main driver 
of their area’s decline. They were also open eyed about the fact that online retail and 
out of town shopping had hit high streets everywhere. But residents looked with 
envy to nearby areas where the town centre was seen to be doing well: in Oldham 
they pointed to Rochdale, in Walsall to Lichfield, in Clacton to Wivenhoe. And they 
felt that if local leaders had given up on the town centre, then they’d given up on the 
area as a whole. What all of these criticisms point to is the failure of some town 
centres to act as a genuine hub of activity where residents want to spend time, meet 
people, eat, live, and work. 
 
Beyond the symbolic value of town centres, our research highlighted their economic 
importance. Low levels of footfall and spend in town centres meant that bars, 
restaurants, and shops struggled to pay good wages and stay afloat. Low quality 
office space meant that businesses didn’t want to locate and grow near amenities - in 
South Tyneside we heard that one small design business had located on King Street, 
but felt embarrassed to bring clients there and so were looking for new premises in 
another town. Barry provided a promising town centre for economic development, 
with investments in the waterfront area supporting independent cafes and co-
working spaces for creative businesses. 
 
Town centres offered an important forum for strengthening an area’s social fabric, 
through shared spaces and rituals that brought together different parts of the 
community.2 Markets were a common bright spot: Tommyfield Market in Oldham 
was described as “buzzing” with activity in the past and served as a weekly 
destination for people in surrounding neighbourhoods. The relocation of Walsall 
market by the council away from the centre of town was seen by residents as a 
mistake that took away an important meeting place. Our “levelling up taskforce” 
exercise almost always generated the idea that councils should subsidise small 
businesses looking to locate in their area. Town centres that bring people together 
were seen to foster a sense of belonging. 
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Residents' also wanted to see improvements to the state of the public realm. 
Sometimes these were small, like overflowing bins on street corners or graffiti on 
bus stations. Other times it was more significant, like burned out buildings or 
boarded up shop fronts. All of these signs of blight served as a regular visual 
reminder to members of the public of the decline of their area. And residents were 
clear that they wanted their town centre to have a distinctive character - to be 
"somewhere" and not just "anywhere". Details and beauty mattered. Where heritage 
and local designs had been maintained, they were noticed and commented on. 
Where they had been replaced by faceless developments, they were missed. 
 
Some saw physical decline as a result of a broader moral decline and a lack of pride 
in the community. Focus group participants argued that people were more willing to 
drop litter or fly tip than they were in the past, and that this was a sign that people 
no longer cared. Others pointed to council failings, arguing that they weren’t 
investing in the town like they should. This criticism was particularly pointed when 
some areas were kept up more effectively than others - in both South Tyneside and 
Clacton, members of the public resented the amount of care that went into the 
waterfront for visitors when the residential areas a few roads away looked far less 
pristine. 
 

3. Supporting local sport, culture, heritage and green 
space 
 
The parts of a place that generate pride are often rooted in culture and history. In 
Walsall, residents pointed towards the local leather museum that charts the area’s 
industrial past, or the Arboretum in the centre of the town that was first made a 
public park in 1870. In Clacton, locals spoke about the Pier, which has been in 
operation since 1871 and used to attract visitors from across the country to shows 
featuring killer whales and dolphins. In South Tyneside one resident pointed to the 
town hall as an impressive heritage asset, saying “we have a gorgeous town hall, I’m 
proud of that, I deliberately take the long way to drive past it”. These deep roots 
make pride in place difficult to generate quickly, putting a premium on protecting it 
where it exists. 

 
Sport has a particular resonance when it comes to levelling up. When we asked 
people in Oldham to explain their area’s fortunes, they pointed to Oldham Athletic 
and Oldham RFC as an analogy for the area’s decline. Oldham Athletic in particular 
were on the route to relegation, making them the first team who had played in the 
Premier League to be demoted from the EFL. Residents saw this misfortune, driven 
by speculative foreign ownership and poor stewardship, as robbing them of a source 
of pride and shared identity. In contrast, South Tyneside hosted South Shields FC 
who had invested heavily in community facilities to support local residents. In 
Oldham, the formation of a kabaddi league had created a new avenue for South Asian 
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communities to come together and celebrate their culture. Overall, the facilities to 
support these activities were lacking - densities of both leisure facilities and green 
spaces in all the areas we visited were below national averages. 
 
Where shared cultural events took place, they were a source of local pride and gave 
areas an economic boost. The Clacton Air Show which attracted around 250,000 
visitors a year was cited by numerous local leaders and focus group participants as a 
rare positive aspect of the area’s economy. The “GlastonBarry” festival in Barry was 
also highly spoken of as an event which brought people together. But these sorts of 
activities were broadly lacking in the places we visited. Despite the presence of the 
New Art Gallery in Walsall, the area has one of the lowest rates for cultural 
participation in the country.3   
 
Figure 7:  Share of population that have participated in arts or cultural activities, 2017 
Source: Arts Council England, Active Lives Survey 2015-17 

 
*Note: Directly comparable data for Wales on this measure is not available, but a similar 
measure on participation in arts and culture activities can be found here. The data for all English 
authorities measure the share of population that have participated in an arts or cultural activity 
at least once between 2015-2017.  
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Figure 8: Local Assets per 1000 population, 2022 

Source: ONS UK Business Counts – local units by industry, Onward analysis 

 
*Note: Local assets here refers to a cumulative count of recreation and leisure centres, sports and 
fitness clubs, libraries, and pubs, filtered using 2007 Standard Industry Codes (SIC). 
 

Figure 9: Average number of green spaces within a 1km radius 
Source: ONS Analysis of Ordnance Survey data, April 2020 

 
*Note: Green spaces here refer to parks, public gardens and playing fields   
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4. Boosting local growth in the private sector 
 
Stagnant economic growth sits underneath many of the problems faced in left-
behind areas. Some parts of the Midlands, the North, and Wales have been hit 
particularly hard by deindustrialisation, like the decline of the collieries in South 
Tyneside, manufacturing in Walsall and Oldham, or the docks in Barry. In coastal 
communities like Clacton the decline of domestic tourism has had a profound impact 
on the local economy. In all of the areas we spent time in for our research, a 
struggling private sector has generated too few jobs, offering too little pay, with 
limited opportunities for progression. 

 
In the UK, most levers affecting economic policy sit in Westminster. Local councils 
and regional mayors have a limited ability to raise and direct tax revenues, and 
tightly controlled powers in areas like adult skills or infrastructure investment. 
Unlike other developed economies, most decisions on industrial policy are taken at 
the national level, including the design and delivery of business support programmes, 
the provision of trade support, and investment in translational research. Onward 
have argued in other research papers that this needs to change.4 

 
But local leaders do have a role to play in growing the local private sector. And 
members of the public expect them to take action. In our focus groups, participants 
regularly held the council responsible for the closure of key businesses or the lack of 
new job opportunities. And business leaders were also clear that they felt councillors 
could be doing more to support their expansion and recruitment. So where should 
local leaders direct their attention in promoting growth? 

 
The foundational economy in struggling areas is crucial, comprising both businesses 
that cater to the local population like shops and restaurants as well as parts of the 
public sector. As noted above, the lack of a strong leisure offer is a major barrier to 
levelling up when it blights high streets and fails to provide things to do for young 
people and families. And an effective public sector and social care sector provide 
essential services to vulnerable groups - as is discussed in more detail below. 

 
Local leaders have a crucial role to play in growing tradable sectors: the portion of 
local economies that produces services or goods that cater to other parts of the 
country or internationally, bringing in investment and jobs. Without a tradable 
economy, areas are reliant on employers that are either part of the public sector or 
are commissioned by it, including colleges, hospitals, or local authorities. These 
organisations can play a crucial role as anchor institutions. But on their own, they 
leave areas reliant on re-circulating limited public funds. We saw this most clearly in 
Oldham, where the public sector had grown to have an outsized role in the local 
economy alongside low-wage sectors like retail and social care.  
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Figure 10: Share of employment in the foundational economy, 2021 
Source: Business Register and Employment Survey data, 2021 

*Note: The foundational economy comprises sectors that are involved in the production of goods 
and services that are consumed by all on a daily basis. This includes the material sectors (such as 
cable utilities and supermarkets), public services (such as health, education and police), and 
supplementary sectors (such as clothing and furniture). For more information see here. 
 
We observed two main obstacles to the growth of the local economy. The first was 
the lack of a clear area of comparative economic advantage or a nascent industrial 
cluster with the opportunity to grow. Areas like Oldham and Clacton had some highly 
productive firms, but no clear strategy for which sectors or industrial opportunities 
were going to generate jobs in the future. Both areas would rely on strong 
connections to nearby cities, particularly Manchester in the case of Oldham, or to 
nearby industrial centres, like the Freeport at Harwich in the case of Clacton. But 
commuter roles would need to be complimented by local industries and there 
appeared to be no collective vision amongst civic or business leaders about where 
efforts would be focussed. This lack of clarity extended to members of the public, 
who were not clear where future jobs were coming from. One focus group 
participant in Clacton told us “If you were looking for a decent job, say you were 
fresh out of university, you need to be able to travel, you’re looking at Colchester, 
Chelmsford or commuting into London.”  
 
The second challenge was the lack of a plan to realise industrial opportunities. In 
South Tyneside, civic and business leaders had focussed on private sector growth 
around decarbonisation, particularly renewables and advanced manufacturing. But 
there were significant challenges in realising the potential of these firms and sectors. 
Land supply was limited, with the council lacking the tools to remediate brownfield 
land and assemble new sites. Recruitment was challenging given limited coordination 
between employers, schools, colleges, and universities. And public awareness of 
these new opportunities was low, with focus group participants telling us that all 
new jobs were in shops, restaurants, or distribution warehouses, unaware that the 
world’s largest offshore wind farm was 150 kilometres off the coast. 
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These twin challenges - articulating and then pursuing private sector growth 
opportunities - need to be addressed to generate the local wealth that underpins 
levelling up. 
 

5. Providing community-based support to the most 
disadvantaged 
 
All of the areas we focused on had pockets of severe deprivation. In South Tyneside, 
local leaders told us about challenges “behind closed doors” including 
multigenerational unemployment, drug abuse, and domestic violence. In Walsall, life 
expectancy differed across the borough by almost thirty years. In Jaywick Sands, an 
area neighbouring Clacton, individuals living in extreme poverty were housed in 
post-war beach huts that are in an advanced state of decay. 
 
Deprivation was often hyper-local. High levels of need at an aggregate level disguised 
hyper-local differences in both the nature and degree of vulnerability. In Walsall, 
economic inactivity in the more economically deprived north of the borough was 
high, at around 1 in 3 adults out of employment compared to 1 in 4 nationally. In the 
south of the borough it was lower overall, but extremely high among women with 
45% out of employment, driven by cultural norms in a largely South Asian 
community. Tackling worklessness in Walsall would be difficult to deliver 
effectively at the local authority level, let alone the regional or national level.. 
 
Figure 11: Levels of economic inactivity, and reason cited 
Source: ONS Annual Population Survey 2021, Onward analysis 
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As well as being hyper-local, these problems often occur in communities that are 
least engaged with the public sector. In South Tyneside, community leaders 
expressed their frustration at Department for Work and Pensions contracts that 
span the whole North East, giving limited flexibility for small civic groups to bid to 
deliver employment support. One community leader expressed her frustration at the 
local council’s approach during the pandemic, saying “all the officers went home 
during covid, and closed their doors, and reinvented the wheel”. In Oldham, we 
heard that the involvement of councillors in the Big Local community project had 
started to politicise funding and undermined efforts by residents.  
 
But even if the public sector more actively commissioned civil society groups, in 
many areas there would be insufficient capacity within the third sector. While in 
Oldham we heard about a “reserve army” of community groups, in some of the areas 
we visited we found a lower density of charities compared to the UK average. In 
many areas local groups struggled to organise given the absence of hyper-local 
governance like parish councils or neighbourhood associations.  
 
Figure 12:  Count of charities per 1,000 population, 2022 
Source: The Charity Commission for England and Wales, Office of the Scottish Charity 
Regulator, Onward analysis 
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Figure 13: Membership organisations per 1,000 population, 2022 
Source: ONS UK Business Counts – local units by industry, Onward analysis 

*Note: According to the 2007 Standard Industrial Codes (SIC), membership organisations are 
those representing interests of special groups or promoting ideas to the general public, on topics 
such as politics and business and trade. See here for more information. 
 

Identifying which challenge is the binding constraint to 
levelling up 
 
Our research suggested to us that far from all areas in need of levelling up being 
entirely different, all faced these five common challenges which were prioritised by 
the public. These common challenges represent only a portion of the problems that 
need to be solved in order to close long-term performance gaps between struggling 
areas and the rest of the country. Many of the steps to close these gaps will rest on 
national policy, particularly around the economy and public services, and will take 
decades.  
 
What these five challenges represent instead are areas where local leaders have the 
insight and levers to make real progress in the short term. Resources will be a 
challenge: many councils have seen significant funding cuts and are facing rising 
pressures from ageing populations and expanding responsibilities. But if prioritised 
and approached through partnership, these are the areas where progress can be 
demonstrated to members of the public, building confidence and creating hope. 
These are the conditions in which the long and difficult work of levelling up can 
succeed. It is only by combining these different steps - local and national, fast and 
slow, social and economic - that levelling up will succeed. 
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While these challenges are common between areas, they differ in degree. In each 
place we visited, one or two of these challenges served as a “binding constraint” to 
levelling up: an issue which, if unaddressed, limited the ability to make progress. In 
Oldham, for example, antisocial behaviour and crime served as the key barrier. 
Without giving residents confidence to walk the streets, local leaders won’t be able 
to increase high street footfall or boost the number of commuters into higher-paying 
jobs in the city centre. In South Tyneside, the binding constraint appeared to be the 
high levels of economic inactivity and long-term ill health. Despite the council 
developing a strong local economic strategy, high-growth businesses struggled to 
recruit their workforce from the local area. 
 
These binding constraints are not always the same across an area. As mentioned 
above, in Walsall challenges with economic inactivity manifested very differently 
across the borough. In Clacton, the need for community support to tackle 
deprivation was particularly acute in Jaywick Sands but the lack of a local economic 
strategy was a barrier to progress in the town centre. So, binding constraints might 
differ both between areas and within areas.  
 
Identifying these binding constraints should be the first step for local leaders. It is an 
area where they have a distinct advantage over Whitehall, and identifying one or two 
problems to solve is the first step in forming a coherent strategy. Using local 
intelligence will be a large part of prioritising problems and developing this strategy. 
In our research we found that qualitative interviews, informal conversations, and 
time spent physically walking around an area helps develop a hypothesis about the 
core challenges that need focus.  
 
But qualitative insight is insufficient on its own. Local leaders should use data to 
confirm their hypothesis, and target interventions on particular groups or 
neighbourhoods to address binding constraints. It is to this data diagnostic approach 
that this report now turns. 
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This chapter offers practical support to local leaders who want to understand the 
barriers to levelling up their area. All of the data that we are recommending for use is 
publicly available, and a data manual in the appendix of this report gives guidance on 
how to analyse it. Each of our research visits used a version of this data summary, 
which we adjusted and adapted based on the challenges and opportunities that were 
surfaced in our qualitative work. 

Throughout this section we’ve selected an area that is commonly discussed as part of 
the levelling up debate - Blackpool - in order to illustrate what the data looks like for 
a particular local authority in the UK. 

Starting out: Relative social and economic strength 
 
A core aim of levelling up is bringing parts of the country that are left behind toward 
national averages. So understanding which areas are below average, and in which 
ways, is a useful starting point. 
 
Throughout our Levelling Up In Practice programme we have made use of two 
graphs that rank areas in terms of national percentiles on two metrics, and then split 
them into quadrants based on whether they are above or below national averages. 
 
The first is for the relative strength of the economy. This plots Gross Disposable 
Household Income per capita, as a measure of economic welfare, against Gross Value 
Added per worker, as a measure of economic productivity. This helps to distinguish 
between dense urban areas that might have lots of productive firms but poorer 
households, and commuter areas that are the inverse. 
 
Figure 14: Gross Domestic Household Income (GDHI) vs Gross Value Added (GVA), per 
capita, in percentile ranks 
Source: ONS Regional Accounts, 2019, Onward analysis 
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The second is for the relative strength of society. This plots “Belonging” scores from 
the Understanding Society survey, a measure of pride in place, with Onward’s Social 
Fabric Index, comprising a wider set of indicators of civic strength. 
 
Figure 15: Social Fabric Index vs Belonging Score, 2020 
Source: Understanding Society Belonging Scores, Onward Social Fabric data, Onward 
analysis 

Together, these two graphs give a sense of an area’s strengths and weaknesses, and 
begin a process of identifying particular binding constraints. An area with low 
productivity but high levels of belonging would benefit from further investigation 
into its economic foundations. An area with high household income but low levels of 
belonging may want to look at data on the resilience of the high street or 
participation in cultural activities and civic life. 
 
Before turning to these more specific measures of an area’s binding constraints, it’s 
important to look at hyper-local measures to understand the spatial dynamics of an 
area’s challenges. 
 

Focussing in: Neighbourhood level measures 
 
Ideally, every levelling up measure would be displayed on a map. In practice, a lack of 
available data at the hyper-local level can get in the way of granular insights.  
 
Key maps that every local leader should consult include measures of: 
 

1. Economic output - which neighbourhoods are generating wealth? 

2. Income - which areas have the highest levels of poverty and which have the highest 
earners? 
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3. House Prices - what are average house prices across the area? 

4. Social Trust - which areas have the strongest connections between people? 

5. Deprivation -  which areas have the greatest levels of social need in areas like 
health? 
 

 

Gross Value Added, in 
£ million 

England and Wales average: £50.3 
million 

2.1 – 4.7 
4.7 – 6.8 
6.8 – 9.2 
9.2 – 12.6  
12.6 – 22.8 
22.8 – 50.3 
50.3 - 303 
 

Figure 16: Gross Value Added by Lower-layer Super Output Area (LSOA) in Blackpool 
Source: ONS UK small area gross value added (GVA) estimates, 2020 
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Note: ‘Net trust’ here measures the difference between those who 
said they always or usually trust their neighbours and those who 
said they are always or usually careful about their neighbours. 

 

Figure 17: Total annual household income by 
Middle-layer Super Output Area in Blackpool 
Source: ONS dataset on income estimates for 
small areas, 2018 

Figure 18:  Median house prices by Lower-
layer Super Output Area (LSOA) in 
Blackpool 
Source: House Price Statistics for Small 
Areas, Table 46, 2022 

House price 
£62,500 – £99,470 
£99,470 - £120,000 
£120,000 - £135,000 
£135,000 - £149,970 
£149,970 - £269,500 

Median house price, England and Wales: £263,500 

Figure 19:  Net trust by MSOA in Blackpool 
Source: Onward report ‘Good Neighbours,’ 2023 

Figure 20:  Health deprivation and disability in 
Blackpool by LSOA 
Source: English Indices of Multiple Deprivation, 
2019  
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Working through: Measures for the five common 
challenges 
 
After gaining a relative understanding of an area’s economic and social strengths, 
and a spatial understanding of hyperlocal challenges, local leaders can turn to 
examining which of the five common challenges might be a binding constraint to 
levelling up.  
 

1. Tackling crime and antisocial behaviour, particularly among 
young people 

 
Crime data is widely available at a local authority level. For our analysis, we have 
used Office for National Statistics data on the number of reports for the types of 
offences we heard about most from local leaders. Our charts look at both the 
changing levels of reports within an area, and how that differs from regional and UK 
averages. 
 
Figure 21:  Recorded cases of crime in Blackpool, by type of crime, 2006-22 
Source: Home Office police recorded crime by Community Safety Partnership, Onward 
analysis 
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Figure 22:  Public order offences in Blackpool, compared to regional and national 
averages, 2006-22 
Source: Home Office police recorded crime by Community Safety Partnership, Onward 
analysis 

*Notes: a) The above data is by Community Safety Partnership (CSP) which equate in the 
majority of instances to local authorities. The North West totals in this figure are that of CSPs, 
which is different to total crime records as it does not account for British Transport Police data, 
areas not covered by CSPs, and crime in unassigned areas. 
b) The data from 2019-21 for the North West and England and Wales are likely to be under-
counted because of a technical reporting issue in Greater Manchester. 
 
Police data alone will give only a partial picture of antisocial behaviour. Some 
Community Safety Partnerships and Police and Crime Commissioners will hold more 
detailed data on antisocial behaviour including reports to local authorities, housing 
associations or public transport providers. Local leaders should compliment the 
nationally available data with these local sources where they can. The 
recommendations section below includes more information on how to use data to 
effectively map and target low-level crime. 
 

2. Bringing life back to high streets and town centres 
 
Consistent data on the vibrancy of high streets is not widely available at a local level. 
One measure that serves as a good proxy is vacancy rates. Data used in Figure 23 
measures the vacancy rates for retail and leisure units (excluding industrial and 
office units) by local authority, region and country. These units are typically located 
on high streets in local areas and so serve as a good indicator to study high street 
vacancy. A second measure is the number of businesses that are locally owned, 
which gives a clue as to the number of independents on the high street. Figure 24 
shows the count of businesses operating a single site, based on VAT/PAYE data at 
the local authority, regional, and national level. 
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Figure 23:  Vacancy rates for retail and leisure units, 202 
Source: Whythawk commercial location data, 2021 

Figure 24:  Number of independent businesses per 1,000 population, 2020 

Source: ONS data on single unit enterprises, 2020 

 
Local authorities or Business Improvement Districts may collect data on footfall in 
town centres using mobile phone or credit card data. This information, particularly 
where mapped, can be invaluable in understanding the degree to which town centres 
are serving as hubs of activity. Given it is not collected consistently across the UK, 
we have not included it here. 
 

3. Supporting local sport, culture, heritage and green space 
 

Issues that inform pride in place, like sport, culture, and heritage, are often difficult 
to quantify. But some data is available that can shed light on whether these issues are 
an area’s binding constraint to levelling up. The first is Arts Council England data 
from the Active Lives Survey on cultural participation. Figure 25 looks at the share of 
the local population that has participated in an arts or culture activity at least once 
from 2015 - 2017. The second is data on the availability of green space, taken from the 
Ordnance Survey, that measures the proximity to parks, playing fields, and gardens, 
shown in Figure 26. 
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Figure 25: Share of population that have participated in arts or cultural activities, 2017  
Source: Arts Council England, Active Lives Survey 2015-17 

*Note: The data for all English authorities measure the share of population that have 
participated in an arts or cultural activity at least once between 2015-2017, the duration of the 
Active Lives Survey.  

 
Figure 26: Average number of green spaces within a 1km radius 

Source: ONS Analysis of the Ordnance Survey data, April 2020 

 
*Note: A green space here refers to any public park, garden or playing field. 
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4. Boosting local growth in the private sector 
 
A wide range of economic data is available at the local authority level. Three types 
of evidence can be particularly useful in understanding a local area's economic 
strengths and weaknesses: 

 
• Industry mix - The ONS Business Register and Employment Survey data reveals 

the employment levels in different sectors, changes over time, and differences with 
regional and UK averages. This can help reveal trends, like a decline in 
manufacturing or growth in professional services, and also issues with the stock of 
existing employers, like an over-reliance on public sector employment. 

• Physical connectivity – Office for National Statistics geospatial data shows areas 
people can travel to by public transport in different windows of time up to 60 
minutes. Data compiled by Onward for our report Network Effects reveals how 
many additional jobs are accessible within 60 minutes using public transport. 

• Skills - ONS data reveals the qualification levels within an area, pointing to 
whether a focus on human capital is necessary to boost local growth. Ofsted data 
can also reveal the quality of schools in a local area based on their performance at 
recent inspections.  
 

Figure 27: Industry composition in Blackpool, compared to regional and national 
averages, 2021 
Source: ONS Business Register and Employment Survey 
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Figure 28: Change in industry composition over time 
Source: ONS Business Register and Employment Survey, 2015-21 

Figure 29: Areas reachable within 15, 30, 45 and 60 minutes on public transport, 2022 
Source: DLUHC Geospatial Travel Isochrones, Onward analysis  

 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

*Note:  Figure 29 was produced using data for a centrally located Output Area in Blackpool 

-6 -4 -2 0 2 4 6

Health
Public administration & defence

Financial & insurance
Transport & storage (inc postal)

Business administration & support services
Property

Construction
Professional, scientific & technical

Motor trades
Agriculture, forestry & fishing

Mining, quarrying & utilities
Manufacturing

Information & communication
Wholesale
Education

Accommodation & food services
Arts, entertainment, recreation & other services

Retail

Change in employment share, in percentage points

Great Britain

North West

Blackpool

15 minutes 
30 minutes 
45 minutes  
60 minutes 
 



 

38 Levelling Up Locally 

  
 

 
 
 

 

Job count 

Great Britain average: 1.88 

47.6%

25.0%

16.5%

4.0%

7.1%

9.0%

0% 10% 20% 30% 40% 50%

Blackpool

North West

England

Share of pupils

Primary
schools

Secondary
schools

9% 10%

22%

17%

27%

7%
10%

17% 17%

37%

7%
9%

15% 16%

43%

0%

10%

20%

30%

40%

50%

No qualifications NVQ1 NVQ2 NVQ3 NVQ4+

Sh
ar

e 
of

 p
op

ul
at

io
n

Blackpool North West United Kingdom

0.6 – 0.9 
0.9 – 1.0 
1.0 – 1.05 
1.05 – 1.2 
1.2 – 1.3 
1.3 – 1.4 
1.4 – 1.6 

 

 

Figure 30: Jobs reachable within 60 mins 
on public transport for each job within a 
5 mile radius  
Source: Onward report ‘Network Effects,’ 
2021 

Figure 31: Share of pupils in underperforming 
primary and secondary schools 
Source: Ofsted inspection outcomes, 2022 

Figure 32: Share of population by highest level of qualification, 2021 
Source: ONS Annual Population Survey, December 2021 
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5. Providing community-based support to the most disadvantaged 
 
There are a wide range of indicators and tools that can help to understand the level 
of social need in a local area. The most commonly used is the Index of Multiple 
Deprivation, used in the maps above to identify levels of hyper-local need.  

 
A useful proxy in understanding whether disadvantage is a barrier to levelling up is 
economic inactivity, and the drivers behind it. This data is collected by ONS regularly 
and reported at a local level. This data should be looked at alongside a population 
pyramid for an area, to ensure that an unusual age profile is not behind gaps with 
national averages. 
 
Figure 33: Economic inactivity by reason, as a share of population aged 16-64 
Source: ONS Annual Population Survey, 2021 
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Figure 34:  Population pyramid for Blackpool, by 5 year age-band and gender 
Source: ONS Annual Population Projections, 2021, Onward analysis 

  

-10% -5% 0% 5% 10%

<1

1 to 4

5 to 9

10 to 14

15 to 19

20 to 24

25 to 29

30 to 34

35 to 39

40 to 44

45 to 49

50 to 54

55 to 59

60 to 64

65 to 69

70 to 74

75 to 79

80 to 84

85 and over

Share of population in that age band

Fi
ve

 y
ea

r g
e 

ba
nd

B: Female B: Male UK: Female UK: Male

10% 5%

  United Kingdom   Men   Women 



 

41 Levelling Up Locally 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Taking action 
 

Playbook of interventions 

 

 
 

The path ahead 

 

 



 

42 Levelling Up Locally 

Leaders in communities are not only best placed to identify local challenges, they are 
also best placed to begin tackling them. Many councillors, business owners, and civic 
leaders will have limited resources and multiple calls on their time. Local authorities 
have struggled with reduced funding since 2010 which has limited their ability to 
deliver benefits for their residents beyond statutory services - a challenge discussed 
in other Onward research.5 But this places an even greater premium on focussing on 
interventions that are evidence-based, and steps that leverage support from 
communities and businesses so councils don’t need to go it alone. 
 
The recommendations below are designed for local leaders. They can be 
implemented with the powers and resources already available to them, and have 
been tried and tested in other areas either in the UK or abroad. While these 
interventions do not rely on Westminster, Ministers can still play a positive role. 
National Government departments should support these efforts where they can, at 
times by stepping in with investment or new powers and at other times by stepping 
out of the way.  
 

1. Tackling antisocial behaviour, particularly among young people 

 
Around 5% of neighbourhoods in the UK are responsible for over 50% of crimes.6 
Hot spots policing identifies where these high-crime clusters are and focuses 
resources on them. This place-based approach contrasts with the person-based 
approach that has historically been more common in policing. A hot spots approach 
is particularly relevant for neighbourhood policing that focuses on antisocial 
behaviour, which our research visits have shown often occurs in public areas like 
town centres, tram stops or parks. 

 
There are two broad types of hot spots policing.7 The first saturates an area with a 
greater police presence, increasing the regularity of patrols or the number of 
officers. The second is “problem oriented policing” which seeks to understand and 
tackle the underlying causes that turn neighbourhoods into high-crime clusters. 
 
The evidence for hot spots policing is strong. The Youth Endowment Fund finds that 
hot spots policing reduces overall offending by 17%, with an even higher rate for 
disorder offences (20%) and drug offences (30%).8 A separate international 
systematic review of 65 studies containing 78 tests of hot spots policing found that it 
“generates statistically significant small reductions in overall crime and disorder” and  
didn’t create displacement effects, where crime simply moves to a different area.9  
 

1.1 Local leaders can collectively identify antisocial behaviour hot spots and 
focus their resources on solving underlying problems in those areas 
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The review actually found diffusion effects: reductions in crime in the areas 
surrounding the hot spots. The US National Research Council concluded that 
“studies that focused police resources on crime hot spots provided the strongest 
collective evidence of police effectiveness that is now available.” 10    
 
Pilots have taken place in the UK in recent years that have shown the potential 
benefits of hot spots policing: 
 

● Southend-On-Sea: 2.6% of the geographical area of Southend-On-Sea in 
Essex is home to 41% of crime. 11A Randomised Control Trial in 2020 
concentrated one-a-day, 15 minute foot patrols in these 20 “harm spots”. 
Street-visible offences were reduced by 30% as part of the trial, with 
researchers concluding that “the use of two-officer foot patrol can be highly 
effective at preventing serious violence in street-visible settings in small 
areas in which such violence is heavily concentrated.”12 Detective Chief 
Inspector Lewis Basford of Essex Police designed the intervention as part of a 
Masters degree in criminology from Cambridge University, studying under 
the founder of evidence-based policing Professor Lawrence Sherman.13 

● Birmingham: A hot spots policing effort in the Perry Barr area of Birmingham 
trialled 5 and 15 minute patrols in areas with high levels of reported antisocial 
behaviour and street crime. Across both types of intervention antisocial 
behaviour reduced by 14%, with a stronger positive effect for less frequent 
but longer patrols compared to more frequent shorter ones.14  

● Bedfordshire: A 2020 study tracked daily official crime reports in a sample of 
21 high-crime neighbourhoods in Bedfordshire. A randomly assigned sample 
of the hotspots received 15 minute foot patrols, some on multiple days. The 
study found that these patrols reduced crime by 40%, with no displacement 
effect. The study also found a “cumulative effect” of additional prevention 
when patrols took place on subsequent days, peaking at three days.15 

 
It is widely acknowledged within policing that the hot spots approach works, 
particularly problem solving policing. A College of Policing study found that 88% of 
officers agreed that problem solving is “an important part of policing in general” and 
86% agreed it is “relevant to almost every area of policing”.16 But just under half of 
survey respondents reported having been involved in a project which they 
considered to be problem-solving in the past 12 months. So why isn’t this approach 
scaling? 
 
Effective delivery is the primary barrier to the roll out of hot spots policing. A College 
of Policing study found “recurrent challenges both in the implementation and 
practice of a problem-oriented approach”.17 43% of officers surveyed by the college 
said they did not have access to information necessary to perform effective problem- 
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solving. Of the 20 forces surveyed by the college, only 14 had produced guidance, of 
which only one referenced how to implement an organisation-wide problem solving 
approach.18  
 
Lack of analytical capacity is a particular challenge in implementation, given the 
need to accurately identify hot spots and measure the impact of interventions in real 
time. This is where local leaders can play a role. Representatives from local 
government, health, policing, and other agencies can work together through 
Community Safety Partnerships to better identify hot spots and target resources to 
solve problems leading to antisocial behaviour. Prioritisation by leadership within 
police forces and by Police and Crime Commissioners can also increase the chances 
of effective implementation. 
 
Hot spots policing to tackle antisocial behaviour can be enhanced by combining it 
with other place-based interventions: 
 

● Alcohol-free zones: The introduction of a Designated Public Place Order 
(DPPO) can reduce antisocial behaviour in places where it is linked to public 
drinking. Our research in Barry found that the designation of the Barry Island 
tourist area as an alcohol-free zone reduced the number of day trippers that 
came to the area under the influence of alcohol and increased the number of 
visiting families. There is limited research on the broader effectiveness of 
DPPOs, but their success relies on them being integrated with broader 
approaches to community policing. 

● Physical realm improvements: In certain hot spots, changes to the physical 
environment can reduce the likelihood of antisocial behaviour - sometimes 
called a ‘situational prevention strategy’. A study in Lowell, Massachusetts, 
found that steps like razing abandoned buildings or clearing up graffiti 
lowered crime by increasing the risk of committing an offence and reducing 
the attractiveness of potential target areas.19 

● Community engagement: Effective problem solving in crime hot spots often 
means building connections with members of the community or residents in 
and around the neighbourhood. This was a core element of interventions to 
reduce antisocial behaviour as part of New Labour’s “New Deal for 
Communities” (NDC) programme. Evidence from the Blakenhall NDC 
partnership in Walsall found that the introduction of community-focused 
Neighbourhood Wardens in 2002 reduced the number of residents who felt 
unsafe alone after dark from 39% to 25% (compared to a national average of 
13%).20 

● Social sector capacity:  A large proportion of antisocial behaviour is driven 
by a small number of individuals who have multiple and complex needs. They 
might be rough sleeping, addicted to drugs or alcohol, or suffering from 
severe mental health problems. A core component of problem-solving  
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policing will therefore be ensuring there are services in the community to 
provide wrap-around support for these individuals when they are referred by 
the police or adult social workers. 

• Data collection and analysis: Effective targeting of resources can be 
hampered if the available data doesn't provide a clear and detailed account of 
antisocial behaviour. Police and Crime Commissioners can work with 
Community Safety Partnerships to bring together police reports and calls for 
service in integrated dashboards, with consistent categorisations of different 
forms of antisocial behaviour. Thames Valley Together, launched by the 
Thames Valley Violence Reduction Unit, is a pioneering initiative to bring 
together different forms of data to better understand and respond to rising 
levels of crime, while also upholding data ethics.21 

 
Community leaders can help to hold public officials to account by spreading 
awareness of the Community Trigger and supporting its use. The Community Trigger 
can be initiated by any member of the public who has reported three or more 
instances of antisocial behaviour within a six month period, and instigates a local 
authority led, multi-agency case review.22 These processes can prompt action on 
problems with a particular resonance to the public, and require agencies to 
investigate in more detail why issues are emerging. Yet awareness of this right within 
communities is low - only 6% of the public are aware of the Community Trigger and 
just 2% say they fully understand it.23  
 
The Government has already taken steps to support police forces introducing hot 
spots policing. In 2021, the Home Office provided 18 police forces with an additional 
£4 million to increase hot spots policing focused on violent crime, inspired by the 
pilot in Southend.24 
 
But the primary efforts to scale hot spots policing and solve place-based problems 
will need to come locally. Leaders from across the public, private, and community 
sectors should work to identify antisocial behaviour hotspots, focus their resources, 
understand underlying problems, and solve them to prevent future offending. 
 

 
Antisocial behaviour on and around public transport has impacts wider than crime. 
Residents who feel unsafe on the bus, tram, or train are less likely to commute or 
visit town centres. Housing near unsafe transport stops won’t benefit from any uplift 
in value, and businesses away from town centres won’t attract customers. These 
harms are particularly acute for women and girls: one study estimated that up to  

1.2  Local leaders can improve safety on buses, trams and trains, as well as public 
transport stops and stations 
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3.7% of GDP can be lost through women’s fears of travelling through reduced access 
to employment and deterred tourism and leisure journeys.25 So making public 
transport safer needs to be a core priority for local leaders. 
 
Hot spots policing has a role to play in making public transport safe. In London, a 
number of pilots have sought to reduce offending on the public transport network. A 
trial on the London Underground network saw a pair of officers assigned to patrol 57 
of the 115 highest crime underground stations for 15 minutes, four times a day.26 
Reported crime dropped by 28% on the patrolled platforms, with most of the 
reduction occurring when police weren’t present - what Professor Larry Sherman of 
the University of Cambridge calls a “phantom effect”.27 Another study on the bus 
network saw a 37% reduction in incidents reported by bus drivers through hot spots 
policing.28 However, a small displacement effect was generated in the area 
surrounding the bus stop due to officers arriving and departing on the bus, which 
increased predictability for potential offenders. 
 
“Eyes on the street” are often the most effective deterrent for antisocial behaviour in 
highly public places like on public transport.  A report by Transport for the West 
Midlands on violence against women and girls highlighted the positive example of 
“Street Angels”, where volunteers patrol public transport at night and offer an 
additional pair of eyes as well as increased support.29 A systematic review of “eye 
cues” - photographs or stylized images of eyes - found that they reduce antisocial 
behaviour by 35% when they are present, compared to only 16% for CCTV.30 Whether 
the eyes are real or artificial, reinforcing prosocial behaviour to deter low-level 
offending is a promising strategy for local leaders to explore. 
 
Improvements to the environment on and around public transport also reduces 
antisocial behaviour. A Home Office Review found that improved street lighting leads 
to significant reductions in crime, with an overall effect of approximately 20%.31 It 
found that recorded impacts were because “lighting increases community pride and 
confidence and strengthens informal social control… rather than increased 
surveillance or deterrent effects”.  
 
This emphasis on prosocial environments was echoed in a National Audit Office  
effectiveness review on antisocial behaviour. It argued that “the cues set out for 
behaviour by those in a position to do so - owners of pubs, police, councils in control 
of litter collection, etc - are all significant contributors to determining whether or 
not criminal activity will occur.”32 Strengthening an area’s social fabric is ultimately 
one of the strongest protections against antisocial behaviour. 
 

 

1.3 Local leaders can support programmes that divert young people away from 
antisocial behaviour, including sport, after school clubs, and mentoring 
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Residents that participated in our focus groups were clear that they saw young 
people as particularly responsible for antisocial behaviour in their area. There is good 
evidence that young adults present a particular challenge when it comes to crime: 18 
- 25 year olds make up less than 1 in 10 of the UK population but almost a third of all 
police cases.33  
 
But participants in our focus group were also clear that they did not necessarily 
blame young people. They argued that there was little to occupy their time 
productively and few economic opportunities for them to take advantage of. 
Members of the public wanted a strong and clear police presence so that they felt 
safe, but didn’t favour an overly punitive approach to low-level offending. Again, 
there is good evidence to support the instincts of the public: a “what works” review 
by the US think tank RAND for the NAO found little evidence to support coercive 
sanctions like Anti Social Behaviour Orders (ASBOs) as an effective form of deterrent. 
 
So alongside hot spots policing and safer travel interventions to tackle offending 
when it occurs, local leaders should prioritise evidence-based interventions to divert 
young people away from antisocial behaviour in the first place. 
 
The 2010 report of the Independent Commission on Youth Crime and Antisocial 
Behaviour makes an important distinction between two types of youth offender: 
“children and young people who commit crime”, who they describe as “adolescent 
limited”, and “a smaller group of prolific, serious, and violent offenders whose 
behaviour is often seriously antisocial from an early age”, who they describe as “life-
course persistent”.34  
 
Much of the literature on which interventions are effective in reducing youth 
offending are focused on the more serious life-course persistent young offenders. 
Evidence-based interventions to divert these young people away from crime include 
child skills training, behavioural parent training (BPT), multisystemic therapy (MST), 
family functional therapy (FFT) and Multi-Dimensional Treatment Foster Care 
(MTFC).35 These interventions are led primarily by local authorities, police forces, 
and Violence Reduction Units in different parts of the UK, and are focused on the 
most at-risk young people who have often experienced significant trauma. 
 
Alongside these efforts to tackle serious youth offending and violence, local leaders 
in areas in need of levelling up should play a central role in preventing low-level 
offending and antisocial behaviour among young people for three reasons: 
 

1. Low-level antisocial behaviour can be a route for young people to more serious 
forms of crime. Research indicates that hanging around on street corners is 
predictive of offending behaviour among young people.36 Engaging young 
people in diversionary activities early can reduce costs and harms further 
down the line. 
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2. Widespread antisocial behaviour can damage an area’s social fabric, causing 
more serious offending in the long term. If residents are scared to spend 
time in public places and the public realm deteriorates, then over time 
environments become more hospitable to crime. If the sense of mutual trust 
and shared obligation that is characteristic of a healthy community breaks 
down, then young people are less likely to develop the prosocial behaviours 
that reduce their risk of offending. 

3. Interventions to divert young people who are only engaged in low-level 
offences are often relatively inexpensive and have spillover benefits. 
Mentoring programmes build relationships that can help build skills and 
secure employment. After school clubs can improve educational attainment 
and work readiness. Engaging in sport can improve physical and mental 
health. These interventions do not draw significant funding away from 
trauma-informed programmes that support the most serious youth 
offenders. 

 
The research on effective diversionary activities for young people points to three 
types of evidence-based community programmes: sport, after school clubs, and 
mentoring. 
 

Sport 
 
Engaging in sport can be a highly effective way to reduce young people’s engagement 
in antisocial behaviour. Our research in Oldham introduced us to the work of social 
entrepreneur Moinul Islam MBE who has been involved in supporting local clubs 
offering boxing, football, and the South Asian sport Kabbadi. In communities like 
Oldham these activities, offered around the school day and at low cost, can be a 
productive way for young people to engage socially and improve their health. 
 
Academic research indicates that participation in sport can reduce antisocial 
behaviour. The Youth Endowment Fund cites a review of 61 studies that finds “a large 
impact on offending” of up to 52%, but caveats this by highlighting heterogeneity in 
the results and limited strength of evidence in studies that make up the causal 
impact.37 The review also finds that single sex interventions, and those with majority 
ethnic minority populations, have large effects. The College of Policing has found 
strong evidence of the effectiveness of broader sport-based interventions, like 
wilderness adventures.38 
 
Evaluations of sports-based interventions in the New Deal for Communities 
programme found that they were most successful when they were part of a 
programme that improved cognitive and social skills, reduced impulsiveness, raised 
self-confidence, and supported education and employability.39 So local leaders 
should ensure that sports clubs are paired with opportunities for coaching and 
mentoring, or involve young people taking on leadership roles and responsibilities. 
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As recent research by Onward found, there are significant regional gaps in access to 
sport.40 Around 60% of young people in the South East and South West participate in 
sport outside of school, compared to around 40% in the North West and Yorkshire 
and the Humber. So local leaders in areas most in need of levelling up may face more 
of a challenge in increasing participation. But local community groups and sports 
clubs are better placed than the national government to get young people involved, 
and will see more of the benefit in reduced antisocial behaviour.  
 

After school clubs 
 
Some young people may engage in sport after school. But well-structured after 
school clubs that offer safe, supervised environments and structured programming 
can be much broader than physical activity. Two systematic evidence reviews find 
that after school clubs reduce minor crimes by approximately 8% for those young 
people who participate.41 The reviews both point to the greater impact of after school 
clubs that offer more than recreational activities, particularly opportunities for 
academic or skills-based activities. 
 
Beyond formal programming, one of the most important roles of after school clubs 
can be to provide a space for young people to spend time with each other that is not 
a park or street corner. An evaluation of one after school programme in Camden 
found that an offsite location was a particular advantage for children and parents 
that were distrustful of public agencies.42 There is a key role for local leaders to play 
in identifying potential sites for after school clubs, and matching them with 
community and educational organisations that could provide activities. Government 
can also play a role in the capital investment for these centres, including through the 
Youth Investment Fund.43 
 

Mentoring 
 
Mentoring programmes involve matching young people with adults to help them 
develop their skills and confidence. Multiple systematic evidence reviews have 
confirmed the effectiveness of mentoring in reducing youth offending and antisocial 
behaviour. The Youth Endowment Fund estimates that mentoring reduces offending 
by 14.2%, and is particularly effective for young men.44 An evidence review on 
diversionary activities by the Barrow Cadbury Trust finds “good evidence that 
mentoring can reduce reoffending and result in positive behaviours amongst people 
under 21”.45 Mentoring programmes can be high cost, meaning they are most 
appropriate when targeted at young people who have already engaged in low-level 
crime or antisocial behaviour. 
 
There is a wide variety in the effectiveness of mentoring programmes, which often 
comes down to design and delivery. A review of 40 process evaluations conducted by 
the Youth Endowment Fund found a number of success criteria for effective 
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implementation of mentoring including mentor recruitment and training, developing 
a strong mentoring relationship, parental engagement, and a well-managed 
termination of the relationship.46 
 
While a range of national mentoring programmes exist, local leaders are well 
positioned to develop local schemes and work with schools, local government, and 
the police to target their support to young people engaging in antisocial behaviour. 
 
One variant on mentoring for which there is emerging evidence is detached youth 
work.47 This intervention sees youth workers meet young people out in the 
community - often in parks, sports cages, street corners, or around the school gates. 
Youth workers engage with young people on any worries or concerns, and can refer 
them to activities or forms of support. A pilot launched in Erdington, Birmingham, 
sees detached youth workers spend time with young people on their route to and 
from school in order to de-escalate any potential violence and promote positive 
behaviour.48  
 

2. Bringing life back to high streets and town centres 
 

 
Vacant properties on high streets and in town centres are the most obvious marker 
of decline. Focus groups in Walsall told us that “once you get three, four, five shops 
shut then the whole place starts to go downhill.” In South Tyneside we heard that 
vacant shops on Kings Street were “depressing” and “awful compared to how it used 
to be.” So a clear priority for local leaders should be reducing the number of empty 
shops, restaurants, and other units in their area. 
 
High streets everywhere have been hit by the rise of online shopping and the impact 
of the pandemic. But this shouldn’t lead to persistently high vacancy rates. If demand 
decreases for units, rental prices should drop until more potential tenants come 
forward. Or property owners should take advantage of new planning flexibilities and 
convert their units into high-quality housing. 
 
Yet this is not happening. High levels of vacancy are driven by some landlords 
choosing to leave their properties unoccupied for long periods of time rather than 
reduce rental prices towards a fair market rate. Big institutional investors are 
particularly to blame. Four ownership categories - investment management 
schemes, financial institutions, overseas investors, and real estate companies - 
account for more than half of UK high street stock.49 Units owned by these 
organisations have significantly higher vacancy rates, between 7 and 10 times greater 

2.1 Councils can issue letters notifying all landlords of long-term vacant 
properties of their intention to trigger a High Street Rental Auction 
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than private individuals.50 To date, councils have had few mechanisms to encourage 
or require these large institutional investors to rent out their properties.  
 
The Levelling Up and Regeneration Bill, due to receive Royal Assent in Spring 2023, 
gives councils a new lever: High Street Rental Auctions (HSRAs).  This is a powerful 
new tool under which local authorities can require landlords of high street units 
empty for more than 12 months to hold a public rent auction, where prospective 
tenants offer bids for the maximum level of rent they are prepared to pay on a fixed 
term lease. The landlord would be legally required to let the unit to one of the bids at 
the end of the auction process for a fixed period of 2-5 years. If a landlord refuses to 
initiate a rent auction, or does not respond to the notice, the local authority would 
have the power to hold an auction and lease the property in absentia, holding any 
rental revenue in escrow if necessary.  
 
It will take local authorities time to build teams that can instigate and support 
HSRAs. But they can immediately put landlords of vacant properties on notice. At 
almost no cost, councils can write to landlords of vacant units informing them of 
their intention to trigger a HSRA. This would nudge landlords towards lowering their 
rents and bringing their properties back into use. And it would help reduce the 
number of actual HSRAs that the local authority would need to trigger once it had 
established its processes.  Identifying these landlords can be a consistent challenge, 
so local authorities should consider pooling their resources (possibly across a 
Combined Authority area) to support teams of legal and property experts that can 
undertake this work 
 
Some smaller private landlords may genuinely want to bring their properties into use 
but are struggling with capital investment. In these instances, councils might choose 
to provide support. In Kent, the County Council chose to distribute loans to property 
freeholders as part of its “No Use Empty” campaign which significantly reduced 
vacancy rates in commercial properties.51 Local authorities could use their HSRA 
warning letters to direct landlords to these types of programmes and other support 
schemes being offered to promote regeneration. 
 

 
Dilapidated and run-down buildings in town centres contribute to the feeling that a 
place is left behind. Common issues in areas we researched included crumbling 
brickwork, broken guttering, smashed windows, fallen fences, and debris around 
properties like dumped furniture, builders’ rubble, and abandoned vehicles. Eyesores 
can discourage people from living in town centres, undermining the transition to 
mixed use which will be key to reducing the reliance on retail. And fundamentally, 

2.2 Councils can tackle eyesores and derelict buildings through Section 215 
notices 
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they make an area less beautiful. If members of the public don't enjoy walking around 
an area or take pleasure in its streets, it is less likely to succeed.52 
Local authorities can require property owners to address these issues through 
Section 215 notices. Section 215 of the Town and Country Planning Act (1990) 
provides a local authority with the power to require land to be cleaned up when its 
condition adversely affects the amenity of an area. The notice sets out what action 
needs to be taken and the period of time that it needs to be addressed in. Property 
owners have some time to resolve the issue informally before the notice comes into 
effect.  
 
The Government issued guidance on Section 215 notices in 2005 to encourage their 
broader use by local authorities.53 Research underpinning the guidance found that 
20% of notices approved in 1998/99 were not eventually served, suggesting that the 
threat of a notice was sufficient to encourage action.54 The research also suggests 
that Section 215 notices are effective in securing compliance: 80% of notices served 
resulted in compliance and only 6% were appealed.55 
 
Section 215 notices have been used by councils across the country. In 2018 
Greenwich Borough Council issued a notice to a property on Plumstead High Street, 
requiring the owner to repair boarded up windows, address a pigeon infestation and 
clear up bird droppings.56 In 2015 Brighton and Hove Council issued 54 notices to 
commercial and residential properties to improve the look of their waterfront area, 
with only 16 needing to be formally triggered.57 In 2000 Hastings Borough Council 
launched “Grotbusters”, an initiative to aggressively and proactively use Section 215 
notices to turnaround the appearance of their town. By 2017, they had secured 
remediation of over 830 buildings and now provide advice and guidance to other 
local authorities on using Section 215.58 
 
Local authorities also have powers under Sections 77 & 78 of the Buildings Act 1984 to 
take action where buildings are unsafe, including where walls or roofs appear 
unstable. And where buildings are listed to recognise their special historic or 
architectural status, councils are able to issue Repair Notices to require owners to 
take steps to improve their physical condition. 
 
The 2021 “No Place Left Behind” commission argued that “local authority capacity 
and culture may be significant barriers to greater use” of Repair Notices and Section 
215.59 Some elected councillors have reported that officials have been reluctant to 
use Section 215 for fear of protracted legal disputes, or do not have the resources to 
identify, produce, and issue notices.60 There are also limitations in what Section 215 
notices can achieve, given that local authorities are not easily able to take ownership 
of the property if problems aren’t addressed. 
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But Section 215 notices, when targeted at particular areas with emotional resonance 
to the public, are a useful tactic in improving the physical fabric of town centres. 
While they require upfront investment, they can generate revenue downstream by 
reducing vacancy rates and increasing business rate revenue. They should be used 
more readily. 
 

 
Local assets and public spaces require ongoing management, regular investment, 
and ultimately a great deal of attention. It can be difficult to maintain this level of 
care for a local place from a distance. That’s why empowering leaders at the 
community level is so important, including through institutions like parish and town 
councils. Councillors at this level are better positioned to look after civic assets, 
deliver services to clean up high streets, and secure investment and support from 
local people.61  
 
In Cornwall, much of the public realm was recently transferred to management by 
parishes and towns, and research has found “considerable improvements in the 
quality of service provision” as hyper-local councils are “able to pay closer attention 
to the buildings and facilities on their patch, and invest in their maintenance and 
improvement.”62  
 
There are similar examples of success across the country:  
 

● Battle Town Council in East Sussex developed a plan to repair and improve 
the local Grade II listed Almonry building.63  

● Flitwick Town Council in Bedfordshire created a five-year Town Strategy, 
including actions to enhance the local village hall and market.64  

● Churchill and Langford Parish Council in Avon employs a parish orderly to 
empty bins, keep footpaths clear, remove fly posting and clean bus shelters.65  

● Sutton Parish Council in Cambridgeshire took on responsibility to deliver 
youth services in order to reduce antisocial behaviour and has successfully 
tackled vandalism and petty crime.66 

 
Yet not enough of the country is covered by parish and town councils. In nearly two 
thirds of England (63%) the lowest level of governance is either a district or unitary 
council.67 There are no town and parish councils whatsoever in over 80 district or 
unitary council areas in England, including many of the UK’s largest municipalities 
such as Plymouth, Blackpool, Stockport, Liverpool and Leicester.68 This is partly 

2.3 Local leaders can increase their collective capacity to improve the public 
realm through the formation of parish and town councils, Business 
Improvement Districts and Community Improvement Districts 
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driven by the multiple barriers to forming a parish and a town council, including a 
resident petition and Community Governance Review. 
 
Local leaders can expedite the process to form a parish or town council. Councils 
could hold an automatic ballot across the whole local authority area to identify 
particular neighbourhoods with a desire to take on greater powers. They could also 
support the process of parishing by proactively engaging with communities around 
high streets or town centres that would benefit from greater care and attention and 
helping them to organise. And leaders from the community and third sector can 
organise residents to pull together numbers for petitions. Outside of these more 
formal processes, local leaders can experiment with new forms of local governance - 
the Levelling Up White Paper’s commitment to “community covenants” provides a 
potential route to channel funds, powers, and assets to more local bodies with 
flexible governance. 
 
It is not just the public sector and communities that can benefit from greater 
collective organisation. The private sector can self-organise to invest in the public 
realm through Business Improvement Districts (BIDs). Under a BID, businesses in a 
specific geographic area contribute a small levy to a central body that provides 
collective services like security, public realm upkeep, and business support like 
networking. There are now 330 BIDs across the UK, collectively investing £146 
million and representing around 124,000 businesses.69 In some areas larger BIDs have 
taken on significant civil engineering projects, such as the Colmore BID in central 
Birmingham which has redesigned several streets and public squares in partnership  
with the local authority.70 Some areas are also experimenting with the creation of 
Community Improvement Districts, which give third sector organisations the chance 
to shape high street and town centre development alongside businesses through a 
BID-style organisation.71 
 
Some local leaders told us that a BID wasn’t appropriate for their area, and that 
businesses would not support a ballot. But a vocal minority of firms often don’t 
represent the broader business community. Even in the challenging commercial 
context post-pandemic, 86 ballots to form a BID in the UK resulted in 82 successful 
outcomes and four failures.72 To overcome hesitancy, councils can offer to subside 
BIDs for the first year of their formation, or guarantee to match investment for 
particular schemes to improve the public realm. 
 

 
High streets and town centres are most successful when they are hubs for 
community. One of the most effective ways of engaging community members in the 
regeneration and maintenance of town centres is to give them control and 
responsibility over assets.  

2.4 Councils can enable the transfer of assets to community ownership 



 

55 Levelling Up Locally 

 
Community-owned assets have multiple benefits. First, transferring assets to 
community groups can build a stronger sense of pride in place by ensuring that 
residents are invested in the future of their area. Second, it can secure the future of 
assets that may be lacking financial investment by harnessing civic capacity and 
making the most out of resources in the community. Third, it can unlock innovative 
uses for vacant or poorly run high street stores by shifting control from local 
authority officers or institutional landlords to smaller and more creative civic groups. 
And finally, it can reduce the financial burden on local authorities by turning under-
performing assets that might be seen as a liability into sites that generate sustainable 
sources of revenue for third sector organisations that might otherwise be reliant on 
public sector grant funding. 
 
There are excellent examples of community-owned high street and town centre 
assets across the country, many of them supported by the charity Power to Change: 
 

● Bootle, Merseyside: the community organisation SAFE Regeneration 
purchased The Lock and Quay pub and turned it into a community centre 
offering business support and incubation alongside arts programmes73 

● Levenshume, Manchester: a dilapidated Victoria train station was turned 
into Station South, a destination cycle café, bar, urban garden and active 
travel hub. Funding initially came from a crowdfunder and charitable grants, 
but the revenue raised from the cafe and venue now makes it self-
sustaining.74 

● Sidcup, London: The New Generation Community Trust successfully 
acquired Blackfen Library from Bexley Council in 2015, refurbishing it and 
turning it into a community centre with a cafe and children’s play area. 
Profits from the cafe, book sales, and events support the community library 
and over 80,000 people visit each year.75 

● Trawden, Lancashire: A village of 2,000 people acquired their local pub, the 
Trawden Arms, along with the village shop, library, and community centre. 
The pub was listed as an Asset of Community Value by the council, which 
ensured residents could raise the funds for the site before it was acquired by 
developers.76  

 
The Local Government Association and Locality, the national membership network 
for community organisations, have prepared guidance on how to support 
communities to take on local assets.77 There are two primary mechanisms that they 
outline. 
 
The first is transferring council assets to community groups. This means land or 
buildings from a statutory body being transferred to a community organisation at 
less than full market value in order to achieve a public benefit. It is underpinned by 
Treasury guidance which recognises the broader societal value of assets. Councils 



 

56 Levelling Up Locally 

that have successfully adopted this approach have often developed a Community 
Asset Transfer strategy as part of their approach to asset management, and 
introduced a designated officer as a first point of contact for asset transfer enquiries 
to coordinate activity across council departments. 78 
 
The second is supporting the Community Right to Bid. The 2011 Localism Act gives 
communities the right to attempt purchase of Assets of Community Value when they 
go on the market before developers can acquire them. To ensure that the community 
has this right, councils need to ensure that they have an up to date, publicly available 
list of Assets of Community Value. Councils can also proactively issue guidance to 
the community to ensure they are aware of this right and make them familiar with 
council processes and legal duties.  
 
Councils can take a range of steps to help community groups take on assets via 
either of these routes. They could offer financial support through grants or loans, 
including things like matching funds for crowdfunding campaigns or low-interest 
loans for asset purchase and repair. They could help facilitate transfer of ownership 
through steps like negotiating the terms of the transfer and providing support during 
the transition period. Councils could engage the community in the process of 
identifying and prioritising assets for community ownership by hosting public 
meetings, setting up an online forum, or forming a task force to gather input. 
Councils could also provide technical assistance in areas like grant writing, financial 
planning, and legal advice. 
 
In 2021 the Government launched the Community Ownership Fund, which provides 
capital grants for community organisations looking to acquire assets.79 As of 
December 2022, just under £17 million had been provided for around 70 projects.80 
Local leaders should seek to maximise the amount of Community Ownership Fund 
investment in their areas by identifying and supporting applications. 

 
Town markets can be vital in restoring civic pride. They boost local economies, 
creating outlets for local independent retailers and allowing consumers to spend 
their money closer to home. They strengthen an area’s social fabric, providing public 
spaces for communities to come together in a collective activity. And they can 
underpin an area’s identity. Residents in Oldham told us that Tommyfield market, 
home to the country’s first chip shop, was once the pride of the town centre. Focus 
group participants said it meant that “Oldham used to be the place to come to” and 
that the area was “the hub of the North West… the market used to be buzzing”.  
 
Vibrant town markets have been key to several regeneration efforts. Altrincham in 
Trafford had a vacancy rate of around 30% in their town centre in 2010.81 The local 

2.5 Local leaders can create thriving town markets 
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council invested £1 million in the refurbishment of their Grade 2-listed market house 
and transformed it into a gastronomic food hub. The market now draws over 7,000 
people a week and in 2015 won Observer Food Monthly’s award for best market.82 In 
Bury, community members took over the management of Radcliffe Market in 2018 
when there were only five stalls in the dilapidated building. Now over 1,300 people 
visit over 30 stalls every week, and the market employs 18 staff on the Real Living 
Wage as well as engaging a network of 25 volunteers.83 The Teenage Market, 
launched by the Government’s High Streets Task Force, focusses on giving young 
people an opportunity to commercialise creative talents and now has 50 locations in 
the UK including Corby, Sunderland and Horncastle.84 
 
Local leaders can take a range of steps to support the creation of town markets. 
Most obviously, local business leaders and entrepreneurs can invest in the creation 
of indoor or outdoor town markets in their local areas. Councils can make it easier 
for investors to find appropriate sites, including asset transfer of historic market 
halls, loosening permitting regulations in town squares or on streets, or the use of 
public land to host stalls. Councils can also provide business support programmes to 
help entrepreneurs set up their stalls, possibly offering business planning advice and 
grants or loans to allow them to set up. 
 
Town markets won’t be right for every area - and there are certainly places in the UK 
where projects involving market halls have turned out to be poor investments, given 
low footfall or a lack of upfront community engagement in design. But in most 
places, local leaders can take steps to drive footfall to town markets by coordinating 
their activities at particular times of week and in particular places. For example, 
organisations running sports, arts, and cultural activities could relocate their 
programming on market day. Town markets are ultimately successful when they are 
at the core of an area’s social fabric - as Tommyfield once was in Oldham. 
 

3. Supporting local sport, culture, heritage and green space 
  

 
Heritage is an underappreciated foundation of levelling up. Research from Public 
First found that it was the third biggest contributor to pride in place, behind only 
local parks and local people and significantly ahead of factors like local businesses or 
football clubs.85 92% of respondents to a Historic England survey about historic 
environment-led regeneration projects felt that it raised pride in their area.86 The UK 
is an international outlier in how much the public values heritage: cultural heritage 
participation rates are 25 percentage points higher than the EU average (65% vs 

3.1 Local leaders can create Heritage Development Trusts and councils can 
designate Heritage Action Zones to protect and improve access to heritage 
assets  
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40%).87 Our research visits found evidence for this on the ground, in the support for 
Walsall’s Leather Museum, South Shields’ Town Hall, and Clacton’s Pier. 
 
Heritage contributes to pride in place by creating and reinforcing a shared sense of 
identity and belonging. It’s about both the historic buildings in towns and cities as 
well as the stories that residents tell each other about the past and the present. 
Research by the University of Newcastle has found that in places with larger 
numbers of heritage assets people have a stronger sense of place.88 And heritage isn’t 
just about the distant past - it can be about industrial history too. 91% of 
respondents to a YouGov survey supported the reuse of mills for cultural, residential, 
commercial, retail or manufacturing purposes.89 When heritage assets fall into a state 
of disrepair, it has a particular emotional resonance and reduces pride in place. So 
local leaders need to prioritise repairing and maintaining these sites. 
 
The most promising action local leaders can take to protect heritage sites is to 
create a Heritage Development Trust. These are organisations responsible for the 
maintenance and management of heritage properties in a particular area. Given their 
focused mission, they are more successful than local authorities or other bodies in 
managing heritage sites and ensuring that they are accessible by the public, as well 
as generating revenue to pay for ongoing investment.  
 
A number of successful Heritage Development Trusts are already in operation across 
the UK, including: 
 

● Historic Coventry Trust: Founded in 2011 with a focus on conserving The 
Charterhouse, a 14th Century Monastery, but now responsible for 22 
buildings: the largest transfer in Europe of public heritage assets to a charity. 
Their aim is to “become the guardian of the city’s heritage in perpetuity.” 90 

● Great Yarmouth Preservation Trust: Founded in 1979 and has been 
purchasing properties since 2013 using low-cost loans from Great Yarmouth 
Borough Council which were contingent on business plans detailing how 
revenue would be generated.  The Trust has delivered 17 successful projects 
generating £8.4 million for the local economy, removing eight sites from the 
buildings at risk register and recruiting 644 volunteers. 91 

● Tyne and Wear Building Preservation Trust: Originally set up by Sunderland 
Council but has been independent since 1986. Commissioned by the local 
authority to complete the restoration of three high street buildings which 
had fallen into a state of disrepair. Secured charitable funding to repair and 
turn the buildings into a record shop, grocers, café and arts venue. 92 

  
Local leaders should take steps to create and grow these Heritage Development 
Trusts. Councils should offer them low-cost loans as up-front capital, and transfer 
assets to them for management. Trusts can access a range of philanthropic funds to 
support their activities. Chief among these funders is Historic England, who operate 
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a wide range of grant schemes, but others include the National Lottery Heritage 
Fund and the Architectural Heritage Fund.93  
 
Heritage Action Zones (HAZs) are a mechanism introduced by Historic England and 
DCMS to focus heritage activity and investment. HAZs are typically established in 
areas with a high concentration of heritage assets, such as historic buildings, 
structures, or landscapes, that are at risk of decline or in need of repair. The first 
wave of zones was completed in 2021/22, and more are currently in development.94 
Local leaders wanting to kickstart progress on regenerating heritage assets could 
combine the formation of a Trust with the designation of a HAZ. 
 

 
Sport came through in our research as one of the strongest sources of pride in place. 
Where clubs were struggling, like Oldham Athletic FC, this had an emotional and 
cultural resonance beyond any individual scoreline. Local leaders looking to promote 
pride in their areas need to pay attention to the fate of these teams. 
 
Many professional clubs are struggling financially. Data from 2020 reveals that six 
English Football League clubs (around 8%) were in acute financial difficulties and 
seven County Cricket clubs were loss-making.95 Last year two Rugby Union teams 
went into administration: Worcester (founded 1871) and Wasps (1866).96 Many of the 
reforms needed to protect these clubs need to be delivered at the national level, 
including steps like the implementation of the Fan-Led Review of Football. But local 
leaders have a key role to play in ensuring the ongoing sustainability of these clubs. 
 
Councils have a particular role to support club premises, which are often their 
largest financial asset. Local authorities should expedite planning and licensing 
decisions affecting clubs and, where possible, provide business rate reliefs and 
broader financial support. They should ensure that all stadiums are listed as Assets of 
Community Value, so that if they are put up for sale the community has a protected 
window to make a bid. And they should work with leaders of schools, colleges, and 
universities to facilitate partnerships that maximise the use of costly floodlit training 
facilities and pitches.  
 
Community leaders can step in when clubs are in trouble. The Bury FC Supporters 
Society were successful in securing £1 million from the Government’s Community 
Ownership Fund to buy the team’s stadium, Gigg Lane. They plan to convert it into a 
community hub that hosts a gym, adult education centre, public meeting area, and 
physiotherapy services to tackle long-term illness in the local area.97  
 

3.2 Local leaders can ensure the sustainability of local sports clubs 
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Non-league teams can also play a role in building local identity: polling expert James 
Frayne has highlighted Long Eaton FC as an example of a “bright spot” in a town hit 
hard by deindustrialisation.98 Local leaders should target resources at these clubs  
that may have a lower profile but greater reach in the community. They could even 
be considered as part of a social prescribing programmes, to support people with 
physical and mental health challenges. 
 

 
Support for culture, sport, and the arts will often come from philanthropic sources. 
This means local leaders will regularly need to bid into national funding pots to 
secure investment. Some bids will be successful, but many will not. 
 
Diaspora networks offer a route to more sustainable funding and in-kind support. 
These networks look to connect diaspora from a particular town or city in the UK, 
and leverage their emotional connection to their hometown to secure support. They 
can also increase the pride of existing residents by highlighting successful “sons and 
daughters” of an area that have gone on to international success.  
 
One of the most established diaspora networks is Made in Stoke-on-Trent.99 The 
network was started by Staffordshire University, backed by organisations including 
the local council, football club, community trust, and counts leading figures from the 
private sector and philanthropists as members. Tech entrepreneur Matthew 
Bowcock, a network member, argues that “there are successful people originally 
from Stoke but now doing incredibly exciting things all over the world, and we’re on 
a mission to persuade them to bring more of that positive activity back to their home 
city.”100 The network has launched programmes to support care leavers and 
regenerate Stoke city centre. There are a range of other place-based philanthropists 
supporting local activity including Jonathan Ruffer in Bishop Auckland, Andrew Law 
in Sheffield, and John Nickson in Blackpool.101  
 
Local leaders can proactively engage these philanthropists by creating institutions 
like community foundations to channel their investments. They could also develop 
philanthropic propositions relating to culture or the built environment to become a 
focus for a diaspora network - possibly through a “Friends of” or “Supporters of” 
network. By leading with a message of pride and connection to a local area, leaders 
stand the best chance of creating a sustainable and successful forum for change. 
 

 

3.3 Local leaders can create diaspora networks as a way to boost pride of place 
and increase philanthropic investment   

3.4 Councils can support programmes to animate the public realm through 
culture and art 
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Culture and art can be a powerful tool to boost pride in place and create a sense of 
local identity.102 Research commissioned by Arts Council England found a strong 
relationship between the number of cultural assets in an area and the level of 
community satisfaction, as well as polling evidence that arts and culture are as 
important as schools when considering whether to move to or remain in an area.103 
Research by The National Lottery Community Fund finds that “projects offering arts 
and heritage activities are more likely than others to result in an increased sense of 
community pride and belonging.” 104And a study of 99 US neighbourhoods designated 
as “cultural districts” found that in these areas growth in property values was 9.3% 
higher, income growth 5.4% higher, and poverty 2.3% lower.105 
 
But accessibility is key. The word “culture” can prompt images of ticketed one-off 
events in closed-off theatres. These events will be a part of any area’s cultural 
offering, but local leaders have an opportunity to support arts that are visible and 
accessible to everyone in public places. 62% of UK adults agree that cultural 
experiences on the high street give them a sense of pride about their local area, 
according to polling commissioned by Arts Council England.106 
 
Across the country, there are excellent examples of local leaders introducing art 
projects that animate the public realm:  
 

● Walsall: A small statue of “Hoppy” the Hippo has been a meeting point in 
Walsall town centre since it was installed in 1972 - often for people to meet 
at, and then go somewhere outside the town.107 Social Enterprise Urban Hax 
and Walsall Council developed the “Hidden Hippo” trail to encourage young 
people to explore their area. They created an augmented reality tour around 
key sites, with digital content triggered by scanning physical hippos dotted 
across the town.108 Young people shared pictures of themselves completing 
the tour, helping them celebrate the area’s craft heritage and discover local 
history. 

● Barnsley: Two phone boxes in Barnsley town centre had become dilapidated, 
attracting anti-social behaviour including graffiti and drug dealing. Barnsley 
Council purchased them for £1 as part of BT’s telephone box adoption 
scheme and transformed them into “Tellapoem” boxes containing a new 
work by former poet laureate Simon Armitage along with graphic design 
from a local artist.109 

● Coventry: In Autumn 2020 the pandemic meant that footfall was low in 
Coventry city centre, and during October half term many parents were 
looking for activities for their children. The local council created the 
“Monster Trail” with large inflatable monsters installed around public 
buildings in the city centre, coming out of windows and on top of roofs.110 
Families walked the trail, trying to spot the monsters and sharing pictures. 
The project significantly boosted footfall and has been repeated in 
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subsequent years, and an FOI request revealed it cost the council only 
£40,000.111 

 
Councils and private landlords can also engage with creative communities on 
temporary or “meanwhile” use of vacant storefronts, on terms that ensure they can 
get it back if a commercial tenancy becomes available. In Plymouth, a group of artists 
and charities took on meanwhile use of six buildings within the city centre and 
created galleries, event spaces, and studios.112 In Bath, the council used grant funding 
to support 12 installations by local artists in the shop windows of vacant commercial 
units, boosting footfall and generating social media buzz for a public investment of 
only £12,000.113 To support this activity, councils should market opportunities for 
meanwhile management of buildings for up to 3 years, retain repair and maintenance 
obligations where they act as the asset owner, only call for an Outline Business Case 
from prospective occupiers instead of significant detail, and offer business rate relief 
where possible.  
 

 
Local parks and green spaces are one of the biggest sources of civic pride. In a poll 
by Public First, 36% of people said that local parks and green spaces make them 
proud of their area - higher than any other response.114 This affinity for green spaces 
was also reflected in our focus groups, with residents pointing to areas like Walsall’s 
Arboretum and South Tyneside’s waterfront.  
 
Land availability and affordability in dense, urban areas limits the prospect of large 
parks and green spaces. Given that almost 84% of the UK population live in urban 
areas, local leaders need to be creative.115 Pocket parks are a green, cost-effective, 
and community-oriented option. They are small-scale green spaces created on land 
with limited alternative development value like vacant building plots, parking areas 
and alleyways, which are often initiated and run by community groups.  
 
Pocket parks can deliver health benefits. One study found reports of anxiety and 
depression for those living within 400 metres of urban green space were 7% lower 
than for those living more than 800 metres away.116 . Another study found that pocket 
parks in low-income neighbourhoods boost physical activity by between 38-50%.117 
They also generate considerable health cost savings -  approximately £2.1 billion 
could be saved if everyone in England had good access to green spaces.118 Pocket 
parks can even drive drown crime. A large-scale study across 301 US cities found 
that even a 1% increase in green space provision was associated with a decreased 
crime risk of almost 40%, particularly burglaries and violent crime.119 
 
Community-led pocket parks can reduce costs of maintenance by attracting 
volunteers - but that means making sure processes to create parks are simple and 

3.5 Local leaders can create “pocket parks” in urban areas 
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accessible for members of the public.120 Local leaders could create customised 
training programmes for community groups and provide assistance on funding pots 
available, eligibility criteria, documentation requirements, partnership opportunities, 
and timelines. Fields in Trust have resources that can help local leaders and 
community groups navigate the planning system to deliver more and better green 
spaces.121 They also provide hyperlocal data on green space provision, explicitly 
identifying neighbourhoods that fall below the basic minimum standard. Local 
leaders could use this metric to identify how their neighbourhoods rank and work 
towards the specified minimum standard.122 Nesta’s “Rethinking Parks” initiative also 
offers lessons on using technology to support park management.123 
 
Good examples of pocket park approaches from the UK and around the world 
include:  
 

● Hackney: Brenda Puech, Chair of the Living Streets Group in Hackney 
campaigned to have underutilised kerbside parking units converted into 
temporary mini gardens called “pop-up parklets” given the lack of access to 
private gardens in most residential units in Hackney. This has now been 
officially adopted by Hackney Council who have provided guidance and 
support on establishing parklets. This has also sparked a national effort to 
create more parklets in neighbourhoods with less car ownership.124  

● Salford: The voluntary group Incredible Edible, in partnership with Age UK 
Salford, run edible community gardens in three vacant plots in Swinton. They 
offer free and fresh produce to all in the community, and serve as a 
communal space for the elderly to socialise and keep active. Incredible Edible 
run more than 100 similar edible gardens all over the country, including in 
Calderdale, Wigan, and Wakefield. 125 

● Philadelphia, USA: The Philadelphia Horticultural Society started the Land 
Care initiative in 2004 to “clean and green” vacant and discarded plots. They 
have redeveloped over 800 properties alongside 18 community groups using 
local volunteer labour. Residents living near renovated plots saw a 40% 
decrease in depression and a 29% decrease in gun violence.126  

 

4. Boosting local growth in the private sector 

 

Across the areas we researched, private sector growth was lacking. In particular, 
there was a deficit of tradeable private sector companies that sold products or 
services outside of an area, either domestically or internationally, to bring in 
investment. Instead, struggling areas relied on the public sector and parts of the 
non-tradeable private sector that primarily cater to local residents like hospitality, 

4.1  Local leaders can develop hyper-local industrial strategies 
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retail, and social care. This ultimately means money is recycled within an area 
leading to lower productivity, fewer jobs, and economic stagnation. 
 
Building an industrial base is not easy. Successful private sector clusters grow over 
decades and rely on complex networks of skilled workers, strong institutions, and 
sound infrastructure. The levers to conduct this sort of industrial strategy often sit 
nationally not locally. And not every area can be home to a private sector cluster - 
some thriving towns will instead become places to live and raise a family, with many 
residents combining working from home with commuting to a nearby town or city. 
But even if the path to local private sector growth is challenging, more local leaders 
should make efforts to pursue it. 
 
The first step is identifying comparative advantages. Areas are unlikely to succeed in 
growing across a wide range of industries, so instead they should focus on specific 
areas of opportunity where businesses could genuinely compete internationally. 
Developing a hyper-local industrial strategy can be a tool to guide this process of 
self-discovery and develop an action plan. Scale is key. Regional industrial planning 
covers functional economic areas that host populations in the millions, but hyper-
local industrial planning should focus on the specific contributions of towns and 
cities with populations likely under a million.  The eventual product could be 
described in a number of ways - an economic or industrial review, commission, plan 
or vision - but the aim of the activity remains the same. As Dolly Parton says: “find 
out who you are and do it on purpose”. 
 
The city of Milwaukee in the US Midwest provides a good example. Historically, 
Milwaukee used its proximity to fresh water in Lake Michigan to become the “Beer 
Capital of the World” in the late 1800s and develop a large tanning industry.127 
Deindustrialisation over the 20th Century hit the area hard, and local leaders needed 
a route to boost private sector growth. The natural route would have been to focus 
on existing sectors like food and drink or textiles. Instead, business leaders 
commissioned research which revealed specific capabilities in water technologies: 
instruments like valves and sensors as well as services like purification and pumping. 
Local leaders developed a coordinated plan to grow water technology firms, 
connecting them to universities and creating the Global Water Center. By 2018, the 
water cluster comprised 175 firms with $10.5 billion in revenues and employed over 
20,000 people.128 
 
In the UK, Oldham offers a good example of hyper-local industrial strategy. Local 
leaders launched the Oldham Economic Review in September 2021 to provide 
analysis and recommendations on the future for the area.129 The review was led by 
figures from local government, business, universities, and further education, and 
held 18 evidence sessions with external experts. Their final report argued that “the 
economic transformation of Oldham must start by breaking the dependence which it 
has on the foundational economy” and argued for a greater focus on manufacturing, 
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logistics, and innovation activities in the area. It also proposed new governance for 
the area’s economy, to bring together fragmented business support programmes and 
make better links between employers and educational organisations.130 
Once local leaders have identified their economic strengths then they need to 
develop the interventions and programmes that will build on them. The remainder of 
the recommendations under local growth in the private sector focus on these steps. 

 
Market dynamics should ensure that firms adopt the most innovative practices and 
identify opportunities to sell to more customers. Competition means that those who 
don’t go out of business, and those who do grow. But a range of market failures mean  
that businesses don’t always have access to the right information, struggle to 
coordinate with other firms, or can’t identify potential customers. Addressing these 
market failures is where local leaders can play a role. 
 
One successful approach to providing business advice and support is “economic 
gardening”. It was pioneered in Littleton, Colorado in the 1990s where officials 
working in economic development committed to growing local firms instead of 
trying to attract big multinationals - “gardening” instead of “hunting”.131 Officials 
focused on stage 2 companies (10-99 employees) and provided them with a range of 
tools to understand market opportunities, develop business plans, and identify gaps 
in their network. In two decades, the employment base in Littleton doubled from 
15,000 to 30,000 and the sales tax base grew from $6 million to $20 million.132  
Crucially, “economic gardening” was not a typical business support programme: it 
employed a highly skilled small team with private sector experience employing 
sophisticated analytics and building strong local relationships. 
 
The broader evidence for business support programmes is mixed. In an evidence 
review by the What Works Centre for Economic Growth, 14 out of 23 business advice 
programme evaluations found a positive impact on at least one business outcome.133 
They found that “a strong relationship and a high level of trust between advisor and 
client” was important for these programmes to be effective, and that they had a 
higher impact on sales and turnover than on employment.134 National programmes 
have also had mixed success. The Government’s “Help to Grow Digital” programme 
was discontinued in December 2022 after low take-up by businesses.135 Other 
programmes have shown more promise. The North West pilot of the Made Smarter 
programme focussing on the adoption of technology in manufacturing created over 
1,000 jobs and around £200m in GVA in its first three years.136 Made Smarter is 
delivered by Combined Authorities, in contrast to the Treasury-led Help to Grow 
scheme, and has now been expanded to other parts of the country. 
 

4.2  Local leaders can provide targeted business support and advice to tradeable 
firms with high growth potential 



 

66 Levelling Up Locally 

Local leaders looking to launch these schemes, including councils and chambers of 
commerce, should carefully review the evidence. The What Works Centre has a 
range of toolkits on business advice, ranging from business mentoring programmes 
to investment promotion.137 A core insight across the evidence is that “light touch” 
interventions like a new website or portal are unlikely to work - schemes need to 
actively engage with firms to support them. Given this degree of engagement brings 
higher costs, local leaders should precisely target the firms they have identified as 
having growth potential. 

 
Businesses across the country struggle to recruit skilled workers. In areas most in 
need of levelling up, this problem is particularly acute. Local leaders have some 
formal levers available to them to upskill their workforce: combined authorities have 
responsibility for the adult education budget and local authorities will operate a 
range of employment support programmes. But given the complexity of the skills 
system, local leaders can also play an informal role in convening and corralling actors 
to address skills gaps.  
 
Soft power in the skills system can be exercised by a range of different actors. Local 
authorities, chambers of commerce, business representative organisations and 
others can step up and take responsibility for joining the dots. Hyper-local industrial 
strategies can identify the areas for focus, which could be a particular sector or 
technological capability. Local leaders are then able to build skills pipelines towards 
those opportunities through a combination of on- and off- the job training, 
qualifications like T-Levels and apprenticeships, and rapid training programmes like 
bootcamps and Sector Work Academy Programmes (SWAPs). Employers are central 
to these partnerships, providing insight to inform training programmes and offering 
employment opportunities to incentivise people to participate in them.  
 
There are good examples across the country of local leaders using soft power and 
informal leadership to bring together partnerships and create new institutions: 
 

● Newcastle: Lockheed Martin and Northumbria University developed a 
partnership in 2022 focused on space and solar physics, as part of the 
defence company's expansion of its space manufacturing and satellite 
activities in the North East.138 Local leaders also held a “Space Skills and 
Suppliers Summit” to facilitate conversations between Lockheed Martin and 
skills providers like local colleges and private training companies. 

● Rotherham: The University of Sheffield’s Advanced Manufacturing Research 
Centre (AMRC) operates a Training Centre which pairs apprentices with over 
460 partner companies including Boeing, Rolls Royce, and Airbus.139 The 
Centre also operates upskilling and retraining programmes which they 

4.3  Local leaders can create new partnerships between businesses, schools, 
colleges, and universities to boost employment 
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develop with industry. Their advisory board includes representatives from 
manufacturing firms across South Yorkshire who share insight on skills gaps 
in their firms and sectors. 

● Birmingham: The business-led West Midlands screen industry body “Create 
Central” partnered with the BBC to develop their Apprentice Hub which 
supports “flexi-apprenticeships” across small businesses in the creative 
industries who struggle to offer full apprenticeships.140 Participating firms 
including Full Fat TV and Optomen Television, part of the funding is provided 
by the West Midlands Combined Authority, and training is supported by 
further education bodies including Solihull Sixth Form College.141 

 

 
Private sector clusters can be held back by a lack of suitable office, lab, or factory 
space. In some instances, the type of site required can be very specific: advanced 
manufacturing firms may need a large land area for factories or proximity to a port, 
while professional services firms may need proximity to other knowledge-intensive 
businesses and access to high quality amenities to attract high-skilled workers. This 
sort of development can require significant investment. And depending on the 
scheme, private investment may need to be unlocked through public sector subsidy 
or new infrastructure. But even without investment, there are actions local leaders 
can take to kickstart the development process. 
 
Mayoral and Locally-Led Development Corporations are public-private partnerships 
with a statutory footing that take on responsibility for the development of a specific 
geographical area. Their typical functions involve spatial planning, attracting 
investment, managing assets, and delivering redevelopment. But their key value is in 
creating effective governance - they bring together a range of local leaders from the 
public and private sector under a single organisation that is locally accountable. 
Their creation signals to the market and investors the intention to focus efforts on a 
particular site, and provide a channel for national government support like financial 
investment or transferring ownership of public land. 
 
Historically, development corporations were initiated by central government. In the 
1980s the Government created the London Docklands Development Corporation 
which transformed the area that became Canary Wharf. The 2011 Localism Act 
provided mayors with the ability to create their own development corporations - the 
first was the London Legacy Development Corporation around the Olympic Park in 
East London, created in April 2012 by the Mayor of London. Devolution deals across 
the UK broadened the ability to create Mayoral Development Corporations, and the 
power has been taken up by local areas to differing degrees. 
 

4.4  Local leaders can increase the supply of employment land by creating 
Mayoral and Locally-Led Development Corporations 
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Ben Houchen, the Mayor of the Tees Valley, has been particularly active in using 
development corporations to support regeneration. The South Tees Development 
Corporation (STDC), created in 2017, brings together 4,500 acres of land south of the 
River Tees and includes the site of the former SSI steelworks.142 The formation of the 
development corporation as a legal entity allowed the mayor to bring together land 
that was previously under fragmented ownership and channel £123 million of central 
government funding towards remediation of contaminated land. More recently, 
Houchen has announced MDCs in Middlesbrough and Hartlepool focussed on town 
centre regeneration.143 
 
The Levelling Up and Regeneration Bill creates a new form of development 
corporation - Locally-Led Development Corporations - which can be created by 
local authorities. Local leaders looking to accelerate development of particular 
employment sites should take advantage of these new powers - forming public-
private boards, identifying assets, and using public land and existing levers like 
Compulsory Purchase Orders. Private investment or national government support 
are not guaranteed, but are far more likely if local leaders have signalled their intent 
and ambition. 

 
A lack of physical connectivity can be a significant barrier to levelling up. 
Inaccessible transport means residents can’t access employment opportunities, 
businesses can’t recruit and local economies don’t grow. Even in an era with 
increased home working, the vast majority of roles still require being in a physical 
location for at least a part of the week. When public transport links are either non-
existent or unreliable, car dependency can be a financial barrier to some and 
congestion will be a problem for many. And the higher carbon emissions from 
widespread commuting by car undermine environmental ambitions. 
 
Transport projects can be long-term and costly. Train and tram projects often take 
decades to deliver. The bus network outside London has been struggling with 
declining ridership, particularly post-covid, and struggles to be commercially viable 
in low density areas. And leaders at the local authority level often need to rely on 
transport authorities at the regional level, who in turn depend heavily on funding and 
support from the national government.  
 
Part of the answer for local leaders is Demand Responsive Transport (DRT). DRT is 
scheduled and operated based on the real-time demand of passengers, rather than 
following a fixed route or schedule. For individuals, this could include ride sharing 
apps like Uber and Lyft. But for whole communities, examples include shuttles or 
buses that respond in real time to the specific needs of residents.  
 

4.5  Local leaders can introduce Demand Responsive Transport schemes to boost 
physical connectivity 
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Using technology that can map demand and plan routes, DRT offers a relatively low-
cost mechanism for local leaders to boost connectivity and productivity. In Lawrence 
Weston in Bristol, a “Big Local” community group called Ambition Lawrence Weston 
engaged with local employers to set up a community shuttle bus that helped 
residents access jobs.144 The community members used evidence of demand to 
advocate for a permanent bus service, which was then introduced by a private 
provider. An academic study of barriers to employment in Bristol found that 
transport factors had led to 19% of local jobseekers having left a job and 26% having 
missed a job interview, and argued for the adoption of DRT.145 
 
In many areas, councils themselves have launched DRT offers. In Hertfordshire 
almost 18,000 passengers have used a service called HertsLynx: a service with three 
16-seater vans that has no fixed routes, operates within a 150 square mile zone, and 
creates routes via an algorithm.146 Local authorities in Essex, Leeds, Surrey, and 
Sevenoaks have launched similar programmes. National government has been 
supporting the rollout of these schemes across the country through investment and 
by producing a practical toolkit for local authorities in designing and delivering their 
DRT programmes.147 
 

5. Providing community-based support to the most disadvantaged 
 
In every area we visited, there were pockets of severe deprivation. Sometimes this 
was in particular neighbourhoods, like Gibbonsdown in Barry or Jaywick Sands near 
Clacton. Other times it was certain cohorts, like families that had experienced 
multigenerational unemployment in South Tyneside. One council officer working in 
public health told us “some communities are a few metres back from the starting 
line, others within the borough aren’t even on the track.” 
 
Deep-rooted deprivation is often the result of decades of poverty and trauma. Fixing 
it does not happen overnight. This section does not focus on the steps that need to 
be taken in terms of national policy and public service design to solve these 
problems for good. Instead, it identifies a small number of initial steps that local 
leaders can take to make progress. It builds on “bright spots” we have observed 
through our research, and believe could have promise elsewhere. 
 

 
Local authorities can struggle to reach those who are most disadvantaged. Lots of 
individuals in poverty or with multiple and complex needs will have had difficult 
interactions with the state and public services, and are unlikely to step forward for 
another programme or initiative. This is where charities and civil society 
organisations have an advantage. They can more effectively identify and engage with 

5.1  Local leaders can create and support networks that build relationships among 
vulnerable groups 
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individuals and families most in need of support. Across the country, many local 
authorities and public service leaders already commission or engage with the third 
sector - although there is scope to do more.148 
 
Harnessing and building relationships between vulnerable groups is one of the most 
promising strategies local leaders can take. That might mean a council connecting 
service users, a charity building networks of the families it engages with, or a local 
social entrepreneur launching a new digital platform. This relational form of public 
services has been supported by a range of think tanks and academics.149 It has gained 
increasing attention since the pandemic, when mutual support networks in  
neighbourhoods flourished and proved effective and resilient.150 And it is popular 
with the public: 64% of service users say they want to be able to get to know other 
people that use the same service.151 
 
The social entrepreneur Hilary Cottam has run a range of pilots across the country 
building networks and relationships to tackle deprivation.152 One programme, 
“Backr”, was designed to tackle unemployment. Cottam based herself in a jobcentre 
and asked unemployed people to be part of a team along with local volunteers who 
were in employment. They used basic technology to connect the teams, where 
unemployed people discussed what sort of job they wanted and team members 
helped to link each other to opportunities. A PwC evaluation of Backr using a 
randomised control trial found that it cost one-fifth of other programs at the time 
and that 87% of members found work or progressed, compared with the 66% failure 
rates of standard job centre approaches.153 
 
There are other examples where councils have taken the lead. The “Mockingbird” 
programme in South Tyneside brings together foster families to provide mutual 
support in a model borrowed from Seattle, USA.154 One home acts as a hub, offering 
advice, training and support to six satellite households - which might include hosting 
children for sleepovers and social events or being there in emergencies. In a 
University of Oxford evaluation of a series of UK Mockingbird pilots 90% of families 
said they received good or excellent support, and participants reported higher levels 
of well-being.155 The “Behind Closed Doors” programme in Leeds supports victims of 
domestic violence, primarily by connecting them with others in the community and 
with statutory services.156 
 
There are a number of practical steps local leaders can take to support these 
networks: 157 
 

● Councils could commission charities to create new networks, agreeing a set 
of outcome metrics like reducing hospital admissions for individuals with a 
particular chronic condition or improving school attendance 

● Public service leaders could refer service users to these networks where they 
exist 
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● Local leaders who own assets could offer them as spaces for members of the 
community to connect - this could include libraries, pubs, town halls, or 
religious buildings like churches or gurdwaras 

● Charity leaders could create new digital platforms to connect people or use 
existing platforms like Facebook or Nextdoor 

● Councils can provide training to officers in how to spot and support 
opportunities to build relational networks 

 
Poor public health often underpins deprivation. Smoking, drinking, unhealthy eating, 
and other behaviours can prove difficult for local leaders to shift. But there is good 
evidence that targeted public health campaigns delivered at the community level can 
make a difference, particularly if local authorities used the full range of levers 
available to them. And the resources held by councils to make an impact in this space 
are significant: local authorities spend over £3 billion each year on public health from 
a grant provided by central government.158 
 
Wigan illustrates what targeted public health campaigns can deliver. In 2018/19, over 
a third of children in Year 6 in the Greater Manchester town were overweight, 
significantly above the national average.159 Only 40% of children were active for at 
least 60 minutes per day. The council launched a “whole society, whole systems'' 
approach combining a range of interventions. A “Let's get Moving” campaign 
encouraged over 12,000 students at 64 schools to participate in a “Daily Mile” of 
walking. 200 young people were recruited as Young Health Champions, serving as 
peer mentors. New mothers were provided with breastfeeding support and healthy 
eating guidance as part of a “Start Well” initiative. The local NHS offered a specialist 
service that supported 324 young people with dangerous levels of obesity. And the 
council match funded allocations from the national soft drinks levy to invest in 
school facilities like gym equipment and playing fields. The campaign demonstrated 
early success: within a year, the number of children who were active for 60 minutes 
had increased by around 20% (from 40% to 48%). 
 
Trusted local institutions can be key to delivering these campaigns. In Fleetwood, 
Lancashire, three GP surgeries in an area of significant disadvantage supported the 
foundation of 28 community groups (like choirs, fishing groups, walking groups) 
instead of more traditional social prescribing focussing on gym memberships. A&E 
attendance in Fleetwood was reduced by an average of 17% and primary care 
demand saw similar falls.160 In Philadelphia, USA, the council trained librarians as  
community health specialists. In 2015, almost 10 percent of the libraries’ 5.8 million 
visitors accessed specialised programs and assistance including nutrition, trauma 
and mental health support.161 
 

5.2  Local leaders can launch community public health campaigns to increase 
wellbeing 
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Interventions to promote active travel can also improve health. An evidence review 
by Sport England found that of 84 studies examining the impact of active travel 
interventions, over two thirds (64) found a positive effect.162 The simplest way for 
councils to support active travel is through the planning system and built 
environment, ensuring that they are investing in cycle lanes and walkways. But 
charities can also play a role. The Active Travel Society launched “Big Birmingham 
Bikes” in 2016 which gave away over 9,000 bikes in deprived parts of the city, 
boosting physical activity and increasing connectivity. A similar scheme has now 
been rolled out in Clacton-on-Sea under the name “Essex Pedal Power”. 

 
Families provide the first line of support when people are vulnerable. But some 
families need support to serve this foundational role, including interventions around 
health, education and early years’ development. This is where Family Hubs can play a 
key role. They are community-based centres that serve as a one stop shop for a wide 
range of services, ensuring easier access for families and smarter use of local 
authority budgets.163 
 
The Family Hubs model holds promise for the country’s neglected neighbourhoods. 
An Institute for Fiscal Studies evaluation of Sure Start programmes (the predecessor 
of Family Hubs), found that hospitalisation fell by 10% for 10-year-olds and almost 
20% for eleven-year-olds in the poorest 30% of neighbourhoods.164 Through early 
detection of child vulnerability and opportunities for child development in early 
years’, Family Hubs can simultaneously address both the causes and effects of low 
social mobility.165  
 
Local leaders can accelerate the rollout of Family Hubs to reduce variation across 
areas. As of 2021, Essex had one Family Hub for every 146 vulnerable families and 
almost 1,500 children in poverty, whereas in London the same figures were 8,700 and 
319,000 respectively.166 In expanding the model, local leaders could cost-effectively 
use existing infrastructure, such as Sure Start buildings, and scale them up to 
become Hubs. There are currently 150 Hubs in England and an estimated 3,000 Sure 
Start Centres, with those most at risk of closure being located in some of the most 
deprived areas.167 Utilising existing sites would also allow for the co-location of 
related services and effective signposting, crucial to tackling low levels of Hub 
awareness among families.168 169 
 
Even within existing Hubs, better targeting is needed. Onward has previously 
recommended that local councils align Family Hubs with Unique Pupil Numbers 
(UPNs) assigned at birth, and more generally with registry offices to drive footfall, 
improve targeting, and ensure better data collection.170 But data sharing between 
service providers remains challenging for Hubs across the country, with just under 

5.3  Local leaders can create Family Hubs in their areas 
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half the Hub workforce reporting supportive IT infrastructure.171 Local authority-
wide data platforms have shown early success. In response to users’ feedback to the 
council to not have to repeatedly “tell their story,” Hubs in Essex now use the 
SystmOne integrated data platform, built in collaboration with the private health 
provider Virgin Care and charity for at-risk youth Barnardo’s. 172 SystmOne data 
reports enabled the Healthy Family Teams to identify families in extreme financial 
distress, and subsequently deliver food and fuel vouchers to almost 2,500 families, 
600 afterschool activity packs, and 40 laptops to families with children that were 
being home-schooled in 2021.173 
 
Family Hubs can also sit within a wider “Cradle to Career” model. In North 
Birkhenhead, a network of charities led by Right to Succeed and funded by both 
Wirral council and local philanthropists have launched a programme targeted at 
deprived families. The programme offers integrated education, family support, and 
community services for residents, delivered by a multidisciplinary team of staff and 
volunteers that have a strong presence in the community. Their team-based,  
hyperlocal delivery model has led to quick case turnovers with minimal lengthy 
referrals. In only its second year running, it has supported four times the number of 
parents and carers compared to its first year (from 401 to 1,494), almost twice the 
number of child beneficiaries, and has received 46% more sign-ups to tailored family 
services.174  

 
Common approaches to community engagement are often ineffective. Councils 
might hold a poorly attended town hall meeting, post adverts in newspapers, or put a 
press release on a website with a survey. These techniques miss the potential for 
members of the public to guide and shape services for the better. 
 
The evidence behind community participation is strong. The National Audit Office 
has argued that “community participation is vital in ensuring value for money in 
public services”.175 Academic studies show that participation can improve outcomes 
in service delivery by harnessing a broader set of experiences and expertise.176 And 
researchers have also found that participation can have benefits beyond the initial 
design of services, with members of the public that feel ownership over a new 
programme volunteering to support it and taking responsibility for its ongoing 
success.177 
 
Across the country, local leaders are experimenting with new forms of citizen 
participation to design services that reach the most vulnerable: 
 

● West Yorkshire: Local NHS leaders convened a citizens panel in June 2021 to 
improve communications around delays to elective care procedures. Nine 

5.4  Local leaders can introduce new forms of community participation in their 
areas to develop and improve services 
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volunteers on the waiting list for planned care met for two hours every 
fortnight over 12 weeks, joined by hospital managers and clinicians. Panel 
members shared the negative impacts on their life and health from delays to 
treatment, and provided feedback to aid prioritisation and communication 
around care. They also proposed practical steps to reduce incorrect referrals 
from GPs and identified procedures that could be performed in a community 
setting as opposed to a hospital. West Yorkshire Health and Care Partnership 
and Healthwatch are now rolling out these citizens panels to other NHS 
Trusts.178 

● Exeter: Local leaders from the council and NHS involved residents in one of 
the area’s most deprived wards, Wonford, in the design and development of a 
Community Wellbeing Hub. The council created a “Community Sounding 
Board” of residents who met regularly, both in person and online during the 
Covid-19 pandemic. The group identified a wish list of outcomes for the hub 
along with more refined proposals which were paired with quantitative  
research. The resulting vision – “What Wanford Wants” - emphasised access 
to and utilisation of green space that the council had previously 
overlooked.179 

● London: Westminster City Council supported a peer research project that 
aimed to understand the needs and experiences of vulnerable 18-25 year olds 
living in the area. The project, “City Within a City”, recruited 17 young people 
who conducted surveys and interviews as well as hosting 6 consultation 
events with young residents.  Their final report was used by the council to 
shape initiatives to reduce knife crime by tackling underlying causes 
including overcrowded housing, access to drugs and alcohol and lack of safe 
youth spaces.  

 
The public participation charity Involve has a “Knowledge Base” for councils and 
other local leaders looking for case studies or practical guides.180 
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This is a step-by-step guide to recreate the data visualisations used in the data 
diagnostic approach in Chapters 3 and 4 (Figures 14 -33). The graphs and maps were 
created using Microsoft Excel and the mapping software QGIS.  
 
Figure 14: Gross Domestic Household Income (GDHI) vs Gross Value Added (GVA), per 
capita, in percentile ranks 

1. From this source, download the data for ‘GDHI per head of population at current 
basic prices’ from Table 2 for each region. Select the 2019 values for all local 
authorities and paste it onto a new spreadsheet.   

2. From this source, download the data for GVA by local authority. Choose the 2019 
values from the A3 tab and paste this onto the previous spreadsheet. Make sure the 
values correspond to the right local authority. 

3. To convert both the GDHI and GVA figures into percentile rank, use the formula 
‘PERCENTRANK (range of values you want converted, data value for the first local 
authority in the column). Use this formula for both GDHI and GVA values.  

4. Select the columns that have data for GDHI and GVA in percentile ranks, go to Insert, 
-> add an X-Y scatter chart, and label the X an d Y axes appropriately. Select your 
local authority’s individual data marker on the graph, and right click to change the 
colour and add labels.  

 
Figure 15: Social Fabric Index vs Belonging Score, 2020 

1. From this source, download the Onward Social Fabric Index, select the score for each 
local authority and paste into a new spreadsheet. 

2. From this source, download the data for ‘belonging score’, select the score for each 
local authority and paste into the previous spreadsheet. Make sure the values 
correspond to the right local authority. 

3. Return to the guide for Figure 14 for instructions on how to convert both the Social 
Fabric Index score and belonging score to percentile rank and to insert a scatter 
chart. 

 
Figure 16: Gross Value Added by Lower-layer Super Output Area (LSOA), 2020 

1. From this source, download the 1998 to 2020 edition of the dataset. Use Table 1  for 
local authorities in England and Wales (Table 2 for Scotland and Table 3 for Northern 
Ireland). Delete all columns other than those containing the names and codes for 
LSOAs, LADs, ITL1 areas, and the 2020 GVA.  

2. Paste your data onto a fresh spreadsheet. Now select all the data, go to Home -> Sort 
& Filter -> Filter. Use the dropdowns near each the LAD Name column title to filter 
out the data for your local authority only. Copy and paste this data onto a new 
spreadsheet as save as a CSV file.  

3. Download the mapping software QGIS for free from here. From the Government’s 
official geography portal here,  go to Boundaries -> Census Boundaries -> Choose 
LSOA boundaries for the right year (usually the latest year before your data was 
published) -> Download as a shapefile. 

4. Open QGIS and go to Open Data Source Manager -> add delimited text and upload 
your CSV file with the raw data. You will see the file appear on the left-hand layers 
panel. Then on Data Source Manager, go to vector and upload your LSOA shapefile. 
You will see the outline of the country appear. 

https://www.ons.gov.uk/economy/regionalaccounts/grossdisposablehouseholdincome/datasets/regionalgrossdisposablehouseholdincomelocalauthoritiesbyitl1region
https://www.ons.gov.uk/employmentandlabourmarket/peopleinwork/labourproductivity/datasets/subregionalproductivitylabourproductivityindicesbylocalauthoritydistrict
https://www.ukonward.com/reports/the-state-of-our-social-fabric/
https://beta.ukdataservice.ac.uk/datacatalogue/studies/study?id=6614#!/access-data
https://www.ons.gov.uk/economy/grossvalueaddedgva/datasets/uksmallareagvaestimates
https://www.qgis.org/en/site/forusers/download.html
https://geoportal.statistics.gov.uk/
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5. Right click where your shapefile has appeared on the layers panel -> Properties -> 
Joins -> Press the green plus icon - > Join your shapefile and your data CSV by 
choosing a common column title (ex: LSOA Code) -> Apply -> OK. 

6. Right click the shapefile on the layers panel once again -> Export -> Save Features As 
-> Name your file - Apply. You will see the joined-up layer appear over your shapefile. 
Now untick the shapefile on the layer panel.  

7. On the Layer Styling Panel on the right side, from the dropdown choose ‘Graduated,’ 
and select the value that you want dispersed on your map. Then press ‘Classify’ - this 
should produce the map of only your local authority. Right click on your joined layer 
on the left panel ->  filter ->  double click the data variable at the very bottom of the 
list, then type > 0. Then press OK, and press the Classify button once again. 

8. Choose an appropriate colour ramp from the right hand layer styling panel, and adjust 
the number of classes you would like seen on your map. 

9. LSOAs do not have names, only numerical codes, so to easily identify areas in the 
map, Middle-Layer Super Output Area (MSOA) names will have to be used. To do this, 
go back to the open geography portal in step 3, but this time download the MSOA 
shapefile. From the House of Commons MSOA names site, download the MSOA 2011 
names. Use the sort and filter function (refer to Step 2) to filter get data for your local 
authority only. Title a fresh column ‘value’ and add a random numerical value to each 
of your local authority’s MSOAs (ex: 10). Keeping only the columns value, msoa11cd, 
msoa11hclnm, save as a CSV file.   

10. Follow steps 4-6 to add this to QGIS, except use the MSOA2011 shapefile instead of 
LSOA. On the left hand layers panel, drag your MSOA layer to the top of the layers 
panel to ensure that these boundaries are the uppermost layer on your map.  

11. You only want the MSOA boundaries for your local authority to show. To dissolve the 
others, right click the layer -> ‘filter’, and a ‘Query Builder’ will pop up. Under ‘Fields’, 
select the variable ‘MSOA name’ or your equivalent. This will appear in the box at the 
bottom, ‘Provider Specific Filter Expression’. If it is not already in quotation marks, 
add them like so “MSOA name” -> “MSOA name” = “[insert specific name of MSOA you 
want to appear]”. To add further MSOAs, add ‘, OR’ from the ‘Operators’ panel and 
repeat the above with each name you want. Click ‘Ok’. You should now see the 
outlines of just the MSOAs for your area. The image below shows the first lines of 
code for this function for the local authority Blackpool. 
 
 

 
 
 
 
 
 
 
 
 

 
 

https://houseofcommonslibrary.github.io/msoanames/
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12. Click on the MSOA boundaries, go to the Layer Styling panel, choose the labels 
section (just below the brush icon) - from the dropdown choose single labels to add 
labels by either MSOA name.  

13. To save the map - go to ‘New Print Layout’ -> title your map -> on the pop-up window 
choose the ‘add map’ icon and scale your map to size on the white area. Repeat the 
same process to add the legend to your map.  

 
Figure 17: Total annual household income by Middle-layer Super Output Area (MSOA), 2018 

1. Download the data from this source for local authorities in England and Wales, this 
source for Scotland, and this source for Northern Ireland, and choose the 2018 figures 
for your local authority. 

2. Then paste them onto a new sheet clearly labelling each column (MSOA Code, MSOA 
Name, LAD Code, LAD Name, and total annual income 2018 are the ones you need). 
Add the House of Commons MSOA names adjacent to this in a fresh column. Save this 
file as a .csv file 

3. Follow steps 3-8 from the guide for Figure 16 to add your data and MSOA boundaries 
to QGIS, and step 13 to save your map and legend. 

 
Figure 18: Median house prices by Lower-layer Super Output Area (LSOA), 2022 

1. Download data for median house prices, for England and Wales here (2022); Scotland 
here (2021); Northern Ireland here (2021). Then paste the data for your area of interest 
onto a new sheet clearly labelling each column (LSOA Code, LSOA Name, LAD Code, 
LAD Name, and median house prices are the ones you need).  

2. Follow steps 3-15 from Figure 16 to add your house price data to QGIS, connect these 
with LSOA boundaries, use MSOA labels and save your map and legend.  

 
Figure 19: ‘Net trust’ by Middle-layer Super Output Area 

1. Download the data from this source (England only), selecting the ‘net_trust’ column 
and the corresponding MSOA code and MSOA name. Sort the MSOAs into percentile 
rank (as shown in Step 3, Figure 14) 

2. Then paste them onto a new sheet clearly labelling each column. Add the House of 
Commons MSOA names adjacent to this in a fresh column. Save this file as a .csv file 

3. Follow steps 3-8 from Figure 16 to add the data and MSOA boundaries to your map, 
and 13 to save your map and legend.  

4. To have the same categories as used in this figure, select the joint up MSOA file from 
the left hand layers panel, under Classes, double click the values column, define the 
range you would like seen. To change the way the category labels are displayed (for ex 
to change the label from 0.10-0.20 to ‘least trusting 10% - 20% of MSOAs), double 
click the legend column and type in the way you want your legend labels to appear. 
 

Figure 20: Health deprivation and disability by Lower-layer Super Output Area (LSOA), 2019 

1. Download data for health deprivation and disability under the components for 
deprivation in the English Indices of Multiple Deprivation, 2019 by LSOA. For Wales 
here; for Scotland here; for Northern Ireland here.  

2. Then paste the data for your area of interest onto a new sheet clearly labelling each 
column (LSOA Code, LSOA Name, LAD Code, LAD Name, and median house prices are 
the ones you need). Rank by percentile rank (as shown in Step 3, Figure 14)  

https://www.ons.gov.uk/employmentandlabourmarket/peopleinwork/earningsandworkinghours/datasets/smallareaincomeestimatesformiddlelayersuperoutputareasenglandandwales
https://www.gov.scot/publications/banded-income-statistics-2018/
https://www.nisra.gov.uk/publications/employee-earnings-ni-2022
https://houseofcommonslibrary.github.io/msoanames/
https://www.ons.gov.uk/peoplepopulationandcommunity/housing/bulletins/housepricestatisticsforsmallareas/yearendingjune2022
https://statistics.gov.scot/slice?dataset=http%3A%2F%2Fstatistics.gov.scot%2Fdata%2Fresidential-properties-sales-and-price&http%3A%2F%2Fpurl.org%2Flinked-data%2Fsdmx%2F2009%2Fdimension%23refPeriod=http%3A%2F%2Freference.data.gov.uk%2Fid%2Fyear%2F2021
https://www.finance-ni.gov.uk/publications/annual-ward-district-electoral-area-and-local-government-districts-statistics
https://github.com/ukonward/good_neighbours
https://houseofcommonslibrary.github.io/msoanames/
https://houseofcommonslibrary.github.io/msoanames/
https://www.gov.uk/government/statistics/english-indices-of-deprivation-2019
https://www.gov.wales/welsh-index-multiple-deprivation
https://www.gov.scot/publications/scottish-index-of-multiple-deprivation-2020v2-ranks/
https://www.nisra.gov.uk/statistics/deprivation/northern-ireland-multiple-deprivation-measure-2017-nimdm2017
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3. Follow steps 3-14 from Figure 16 to add your health deprivation data to QGIS, connect 
these with LSOA boundaries, use MSOA labels and save your map and legend.  

 
Figure 21: Recorded cases of crime, by type of crime, 2006-22 

1. From this source, download the data for ‘Police recorded crime open data by 
Community Safety Partnership separately for the years 2016-22, 2012-15, 2008-11, and 
2003-07. This is the source for similar crime data for areas in Scotland, and this 
source for areas in Northern Ireland (Pivot Table 1 under Police recorded crime 
Annual Trends 1998/99 to 2021/22) 

2. The next step is to merge the data in each workbook into a single spreadsheet instead 
of having it split across tabs. To do this, create a separate for each year’s data, and 
convert this into a table format. To do this, select the data -> Insert -> Table, and 
ensure that your table is named the same thing (Table1 for example) in each 
spreadsheet. Collect all your spreadsheets and save them onto a single folder. Then 
open a fresh spreadsheet, go to data -> Get data from -> File -> Folder -> Choose your 
relevant folder -> Open -> Combine and Load to -> Select the name of the table -> 
Add. This should add all your data into a single spreadsheet. This process will have to 
be repeated for each year group set, for 2003-07, 2008-11, 2012-15, and 2016-22.  

3. Use the pivot table function to filter out data for the following categories and sub-
categories of crime for each year group: domestic burglary, public order offences, 
violence with injury, violence without injury, drug offences, sexual offences, violence 
without injury, and non-domestic burglary for each year group.  The pivot table 
function is explained in Figure 23. 

4. Select the data for your local authority only and paste it onto a fresh spreadsheet for 
each year from 2006 onwards. Then Insert -> Add line chart, and label your axes 
appropriately.  

 
Figure 22: Recorded cases of public order offences compared to regional and national 
averages, 2006-22 

1. From the same source as Figure 21, download the data and paste onto a fresh 
spreadsheet 

2. Sort the data to have only public order offence crimes for each year group. Use 
lookup files as mentioned in the Figure 23 guide to get corresponding region and 
country names, and paste this besides the Community Safety Partnership column. 

3. Use the pivot table function as mentioned in the guide for Figure 23 to get the data 
over time for your local authority, region, and country. 

4. To make this data comparable, it has to be indexed against a base year. We have 
chosen 2006 as a base value of 100 and expressed the recorded cases of crime as a 
fraction of this 2006 value. To convert the recorded cases of crime into indexed form, 
use the formula, copy the data relevant to your local authority and paste onto a set of 
fresh cells. Replace all 2008 values with 100. For 2007 values and onward, use the 
formula =100*(2009 value/2008 value), and replicate this for each year and category 
of crime.  

5. Then select your indexed data, including for the year 2006, go to Insert -> Line chart, 
and label your axes appropriately. 

 
 
 

https://www.gov.uk/government/statistics/police-recorded-crime-open-data-tables
https://www.gov.scot/publications/recorded-crime-scotland-2020-2021/pages/15/
https://www.psni.police.uk/about-us/our-publications-and-reports/official-statistics/police-recorded-crime-statistics
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Figure 23: Vacancy rates for retail and leisure units, 2021 

1. From this source, download the data. This is only for England and Wales, comparable 
data is not available for Scotland and Northern Ireland. The relevant columns needed 
to produce this visualisation are the first 7 columns, copy these and paste onto a fresh 
spreadsheet.  

2. Use the sort and filter function as shown in Step 2 of Figure 16 to select only the data 
for 2021 and retail and leisure units.  

3. Title a fresh column ‘vacancy rates’ and use this formula to calculate retail and leisure 
vacant rates for each local authority: =count_total_void/count_total. Select this data 
and convert into percentages by clicking the % icon under ‘Numbers’ in the ‘Home’ 
section 

4. To get the corresponding regional average for your local authority, a lookup file will 
need to be used. These can be found on the opengeography portal here under 
‘Lookups.’ These are simply spreadsheets that list all the lower level geographies and 
the higher level geographies they correspond to. For this visualisation, we require the 
lookup file for ‘Local Authority District to Region.’ Choose the lookup file whose time 
stamp corresponds to the date of publication of the data, as local authority 
boundaries change frequently. Download this, and copy the data and paste onto the 
spreadsheet with the vacancy rates. 

5. Sort your vacancy data in alphabetical order by local authority code, and do the same 
for the lookup data you have just pasted. This will match your local authority districts 
to their corresponding regions.  

6. To get regional averages, a pivot table is a good tool to use. Highlight all your data 
(local authority names and codes, corresponding regions, and vacancy rates. Then go 
to Insert -> Pivot Table on a new spreadsheet. From the right hand panel, drag and 
drop ‘Region’ into Rows and ‘Vacancy rates’ into Values. To ensure that region-level 
vacancy rates are in averages, click on the down arrow next to vacancy rates under 
values -> Value field settings -> Choose average -> OK.  

7. To get a national average, use the formula =AVERAGE(select entire column with 
vacancy rate data).  

8. Finally, copy the data for your local authority, for your regional average, and the 
national average, and paste it onto some empty cells. Select this data -> Insert -> Bar 
Chart. Label your axes appropriately.  

 
Figure 24: Number of independent businesses, 2020 

1. From this source, download the data.  Copy columns A, B and T and paste onto a fresh 
spreadsheet. Then download population estimates by local authority, region, and 
country from NOMIS (go to the NOMIS webpage -> Query data -> Population 
Estimates /Projections -> local authority by five year age band -> select the 
corresponding geographies - in this case that is all local authorities, regions, and the 
United Kingdom, the year - 2020 in this case, and other variables, and press 
download). Copy the population data and paste onto the previous spreadsheet 
adjacent to the data for business count, such that the data corresponds to the right 
local authority.  

2. Then title the next column ‘Number of independent businesses per 1000 population.’ 
To normalise this data by population, use the formula =number of 
businesses/population*1,000, and extend this formula for all local authorities, regions 
and countries.  

https://www.whythawk.com/index.php/research-reports/25-openlocal-uk-sqwyre-com-commercial-location-data-aggregations-for-england-and-wales-as-of-july-2021
https://geoportal.statistics.gov.uk/search?collection=Dataset&sort=-created&tags=all(LUP_LAD_RGN_GOR)
https://www.ons.gov.uk/businessindustryandtrade/business/activitysizeandlocation/adhocs/13198singlesiteenterprisesbyindustry
https://www.nomisweb.co.uk/


 

81 Levelling Up Locally 

3. Choose the normalised data for your local authority, region, and country and paste 
onto a fresh set of cells. The select this data and insert a bar chart. 

 
Figure 25: Share of population that have participated in arts or cultural activities 

1. From this source, download the data (data is not available for Northern Ireland). From 
the Tab B, copy the data for participation rate (%) from column I by local authority 
and paste onto a fresh spreadsheet  

2. Similar to Figure 23, use a lookup file to match local authority names and codes to 
their corresponding regions. 

3. Once the local authority names, codes, region name, country name, and participation 
rate values are in adjacent columns, use the pivot table function (as explained in 
Figure 23) to obtain regional and national averages.  

4. Select the participation rate values for your local authority, region, and country, add a 
bar chart and label your axes appropriately 

 
Figure 26: Average number of green spaces within a 1km radius 

1. From this source, download the data. From the Tab named ‘Urban Google Parks Only’, 
copy the data from column I, ‘Average distance to nearest park or public garden or 
playing field’ along with the corresponding region name, LAD code and LAD name. 
Paste onto a fresh spreadsheet. 

2. Use the pivot table function (as explained in the guide for Figure 23), to obtain your 
regional average. The average for your local authority is already calculated, and you 
can obtain the average for Great Britain using this function in a blank cell: 
=AVERAGE(highlight column containing all averages). 

3. Select the data for your local authority and regional and national average -> Insert -> 
Bar/Column chart, and then label the axes appropriately.  

 
Figure 27: Industry composition 

1. From the NOMIS portal here, go to Query data -> -> ‘Business Register and 
Employment Survey’ → ‘Business Register and Employment Survey: open access (2015 
to 2021). Under ‘Geography’, select ‘local authorities district’ and choose your local 
authority from the dropdown. Choose the relevant region and country, the latest year 
for which the data is available. Under Industry, choose all broad industrial groups, and 
under Percent, choose Industry percentage, and download your data.    

2. Arrange the data such that the list of industries appears in the first column, followed 
by the corresponding values for your local authority, region, and country. 

3. Select this data -> Insert -> Clustered bar chart. Label your axes appropriately. 

4. NOMIS has data only for Great Britain. For Northern Ireland data go here, and follow 
the same steps to create a clustered bar chart. 

 
Figure 28: Change in industry composition over time 

1. Use the same data source and NOMIS query process as in Figure 27 to obtain data for 
your local authority, region, and country from 2015 to 2021. For this graph, download 
the data in absolute count form.  

2. Arrange your data with years as columns and the different geographies as rows. Title 
a fresh column ‘2015-21 change %’ and use the formula = (2021 value-2015 value)/2015 
value. Repeat this for each geography and industry group, and the convert into % 
using the % icon in the Home tab. 

https://www.artscouncil.org.uk/research-and-data/active-lives-survey#t-in-page-nav-2
https://www.ons.gov.uk/economy/environmentalaccounts/datasets/accesstopublicgreenspaceingreatbritain
https://www.nomisweb.co.uk/
https://www.economy-ni.gov.uk/news/business-register-and-employment-survey-2021


 

82 Levelling Up Locally 

3. Repeat for the date from which you want to calculate change in industry competition 
from over time (e.g. 2015 to 2021).  

4. Copy the rows of industry employment for each relevant location - Great Britain, 
region and local authority - and paste into a fresh spreadsheet. Do the same for both 
years.  

5. Select the data for the change % and the corresponding geographies and industries, 
and use the sort and filter function (shown in Step 2, Figure 16) to reorder the data in 
ascending order.  

6. Go to Insert -> Clustered bar chart, and then label the axes appropriately.  

7. This data is only for Great Britain, follow the same steps to create a graph for areas in 
Northern Ireland, for which data is available here. 

 

Figure 29: Areas reachable within 15, 30, 45 and 60 mins on public transport, 2022 

1. Download the isochrone for your region from here. Isochrones are simply shapes that 
connect areas accessible from a fixed starting point within a certain time. This 
shapefile contains travel isochrones for 15, 30, 45 and 60 minutes on public transport 
from fixed Output Areas (OAs). First download the file as a shapefile, and then a 
second time as a CSV. On the CSV, keep only columns B and H (the OA21 code and 
isocutoff) and save this revised version as a CSV.  

2. Open QGIS, then add the ‘Open Street Map’ layout from the browser tab on the upper 
left hand side. Above this layer, add your region’s isochrone shapefile and your revised 
csv, join these layers, export, and format following step 4-8 in Figure 16. 

3. From the joint up layer, filter out to choose a single starting OA. Use the filter 
function shown in Step 11 in Figure 16 to do this. 

4. Save your map and legend following steps 14 from Figure 16. 
 
Figure 30: Jobs reachable within 60 mins for each job within a 5 mile radius 

1. Download data from Onward’s Network Effects Github page here. This data is 
unavailable for Northern Ireland. Select LSOA code, LSOA name, LAD code, LAD 
name, jobs within 5 miles and job count within 60 minutes by public transport. Then 
paste the data onto a new sheet clearly labelling each column. In a new column, 
calculate the ratio - job count within 60 minutes by public transport/jobs within 5 
miles. 

2. Follow steps 3-14 from Figure 16 to add your transport data to QGIS, connect these 
with LSOA boundaries, use MSOA labels and save your map and legend.  

 
Figure 31: Share of pupils in underperforming primary and secondary schools 

1. Download the data from the Lost Learning Github page here, and copy data for 
primary and secondary schools onto separate tabs on a new Excel spreadsheet. This 
data is only for England. 

2. Using the example of primary school data, first select all the data and insert a pivot 
table (as instructed in the guide for Fig 22). Drag LAD Name into Rows, and Total 
number of pupils into values (this has to be a sum), and copy the data on total number 
of pupils for your local authority and paste onto a new tab (name this ‘share of 
pupils’). After removing LAD Name from the rows column, repeat this process to get 
regional and national sums of pupil numbers. Copy the values for your region and 
country and paste them into the share of pupils tab 

https://www.economy-ni.gov.uk/news/business-register-and-employment-survey-2021
https://geoportal.statistics.gov.uk/search?collection=Dataset&sort=-created&tags=all(PRD_ISO)
https://github.com/ukonward/network_effects
https://github.com/ukonward/LostLearningUpdated
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3. Clear all selections on the pivot table, and add LAD Name to the rows section first, 
followed by Ofsted rating. Then drag and drop the total number of pupils to the 
values section. Copy the data for your local authority and paste into the share of 
pupils tab. We are only interested in the number of pupils in ‘underperforming’ 
schools - these are schools that have received ‘Inadequate’ and ‘Requires 
Improvement’ Ofsted rankings. For your local authority, sum the pupil count in these 
categories of schools and paste it into a fresh column besides the total pupil count. 
Repeat the same process for regional and national breakdown of pupil count by 
Ofsted rating, and paste the data for your region and country into the share of pupils 
tab. To convert this into % form, use the simple formula =number of pupils in 
underperforming schools/total number of pupils for your local authority, region and 
country.  

4. Repeat steps 2-3 for secondary school data as well. Select the data for share of pupils 
in underperforming primary and secondary schools for your local authority, region, 
and country, go to Insert -> Column/bar chart, and label your axes appropriately.  

 
Figure 32: Share of population by highest level of qualification, 2021 

1. Go to the NOMIS portal here -> Data sources -> Annual Population Survey -> Query 
data -> as with Figure 27 select the relevant geographies (LAD, region, and country) 
and year. Under Cell, select the Tab T19 - ‘Qualification by age - NVQ’ and Under 
Total, All people aged 16-64, tick the boxes for None (no qualifications), and NVQ 
levels 1 to 4+, and download the data.  

2. You also need to source the data on the total population aged 16-64 for the same 
geographies from the Annual Population Survey data section on NOMIS. Once again 
use the query process on NOMIS. Go to Population estimates/projections -> local 
authority based by give year age band -> select the data for population aged 16-64 
only, and download. 

3. Copy the qualification level numbers into a fresh spreadsheet for all relevant 
geographies and copy and paste  the 16-64 population such that the geographies 
match. 

4. Calculate the share of the total population for each area level that has each level of 
qualification (number with qualification/total population)x100. Click the % button to 
display in % format.  

5. Go to Insert → bar/column chart, and then label the axes appropriately.  
 
Figure 33: Economic inactivity by reason, as a share of population aged 16-64 

1. Go to the NOMIS home page. Go to Data Sources -> Annual Population Survey -> 
Query data -> Choose your local authority, region, and country from the geography 
section and the time period you want the data for (most recent is 2022)  

2.  Under cell, choose ‘economic inactivity,’ and under the Aged 16-64 tab, select the 
data for ‘Total’ and ‘Long-term sick’ for all people, and download this data.  

3. Copy the data for your relevant geographies (delete columns for confidence intervals 
and flags), and paste onto a fresh spreadsheet. Subtract the value of those who are 
long-term sick from the total count of economically inactive, and label this new 
column ‘Other,’ for those who are economically inactive for other reasons.  

4. Using the NOMIS query process, retrieve data for population estimates for your local 
authority, region, and country, for those aged 16-64, and paste this in a new column 

https://www.nomisweb.co.uk/query/construct/components/stdListComponent.asp?menuopt=12&subcomp=100
https://www.nomisweb.co.uk/
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besides your count of economically inactive people who are long-term sick, and for 
other reasons.  

5. On the next column, convert these into % form using the formula = Long-term 
sick/Population aged 16-64, for each of your geographies, and do the same for Other 
reasons. 

6. Then select the data for share of population aged 16-64 that are long-term sick, and 
for other reasons, go to Insert -> Column or Bar Chart -> Stacked chart. Label your 
axes appropriately.  

 
 
Figure 34: Population pyramid by 5 year age band and gender 

1. Using the NOMIS query process, download the data for population estimates for local 
authorities by 5 year age-band for the most recent year. Choose only population 
estimates for your local authority and the United Kingdom, split by gender. 

2. On a fresh spreadsheet, arrange your data such that they are in the following order: 
Age band, Male population for your authority, Female population for your authority, 
Male UK population, and Female UK population. Add column totals at the bottom of 
each column using the sum function =SUM (range of all values you want summed)  

3. Following the same order of columns, on a fresh set of columns, convert the 
population statistics into % form for both your local authority and the UK. To do this, 
use the formula = pop in that age band/column total. 

4. Once again following the same order of columns, on a fresh set of columns, convert 
the population estimates for your local authority and the UK into negative values 
using the formula = -1*population estimate for that age band. This allows the male and 
female projections to appear on either side of the final visualisation. 

5. Now select this data, go to Insert -> Clustered bar chart. Right click the axis -> 
Format axis -> Labels -> Label position -> Low. 

6. Go to Chart Design -> Change Chart Type -> Combo -> Tick the secondary axis check 
box for male and female UK populations. Make sure your upper and lower axes start 
and end at the same values. To adjust either of these, right click the axis whose values 
you want to change -> Format axis -> change the minimum and maximum bound 
values to match the other axis. Once this is done, left click the upper axis and press 
delete. 

7. On all the bars - right click -> format data series -> Series Options -> reduce gap 
width to 0 and increase series overlap to 100% 

8. Select the bars for your local authority and colour them differently for males and 
females.  

9. Now select the bars for male and female UK populations (these will have to be done 
one after the other), right click -> Fill -> No fill -> Border -> Change colour to black. 

10. Add a text box with the values for the left hand side of your x axis with the same 
values as the right hand side and place over the negative values.  

https://www.nomisweb.co.uk/
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